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Manufacturers statement
The WinAQMS Mini DAS package is a state of the art Data logging package that
should give many years of trouble free service if installed, used and maintained
correctly. By following the guidelines contained in this manual and with the
implementation of a good quality-assurance program, the user can obtain accurate and
reliable data. Please ensure that you read the safety and warranty detail as they
contain important information for the user. If, after reading this manual you have any
questions or you are still unsure or unclear on any part of WinAQMS Mini DAS then
please do not hesitate to contact Ecotech.

Notice
The information contained in this manual is subject to change without notice. Ecotech
reserves the right to make changes to equipment construction, design, specifications
and /or procedures without notice.
Copyright © 2010. All rights reserved. Reproduction of this manual, in any form, is
prohibited without the written consent of Ecotech Pty Ltd.
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SOFTWARE LICENCE AGREEMENT
This is a Legal Agreement between you the end user and Ecotech Pty. Ltd. of 1492 Ferntree
Gully Road, Knoxfield, Victoria, 3180, Australia. By opening the sealed disk package you
are bound by this agreement.
1.

Grant of Licence: Ecotech grants you the right to use the one copy of the enclosed
Ecotech Software program on a single computer.

2.

Copyright: The Software is owned by Ecotech Pty. Ltd. or its suppliers and is
protected by Australian Copyright Laws, International Treaty Provisions and all other
applicable National Laws. If the Software is not copy protected, you may either (a)
make one copy of the Software solely for backup or archival purposes or (b) transfer
the Software to a single hard disk provided you keep the original solely for backup or
archival purposes.
You may not copy the Product Manual(s) or written material accompanying the
software.

3.

Other Restrictions: You may not rent or lease the Software, but you may transfer
your rights under this Ecotech Pty. Ltd. Software License Agreement on a permanent
basis provided you transfer all copies of the Software and all written materials, and
the recipient agrees to the terms of this Agreement. You must not decompile or
disassemble the Software. Any transfer must include the most recent update and all
prior versions.
LIMITED WARRANTY

Ecotech Pty. Ltd. warrants that the software will perform substantially in accordance with the
accompanying Product Manual(s) for a period of 12 months from the date of receipt.
Ecotech's entire liability and your exclusive remedy shall be at Ecotech Pty. Ltd's option
either (a) repair of Software or (b) replacement of the Software. This Limited Warranty is
void if failure of the Software has resulted from accident, abuse or misapplication. Any
replacement Software will be warranted for the remainder of the original warranty period or 3
months, whichever is longer.
Ecotech Pty. Ltd. offers no other warranties other than the Limited Warranty contained herein
which gives you specific legal rights. Ecotech Pty. Ltd. has no liability for consequential
damages. In any case, Ecotech's entire liability under any provision of this Agreement shall be
limited to the amount actually paid by you for the software.
This Agreement is governed by the laws of Australia.
Should you have any questions concerning this Agreement, write to Ecotech Pty. Ltd., 1492
Ferntree Gully Road, Knoxfield, Victoria, 3180, Australia – Email: ecotech@ecotech.com.au.
Attention: By opening the sealed packet, you signify that you have read the Ecotech Pty. Ltd.
Software License Agreement and accept its terms.
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Introduction

Thank you for purchasing WinAQMS Mini DAS (Mini Data Acquisition System).
WinAQMS Mini DAS is the result of over 15 years of development,
 Beginning with the 9200 DASs,
 then the DOS based PEMS,
 the 9400 based AQMS software
 the fourth generation Windows/XP based version
 and now the Mini DAS.
We hope that you find this software both powerful and easy to use. Please ensure that
you read the licence and warranty details as they contain important information for the
user.

Figure 1 WinAQMS Mini DAS logger

1.1 Users and Passwords
WINDOWS
WinAQMS Mini DAS comes preinstalled with a licensed version of Windows XP
Home. Windows XP Home requires a password to be entered for a user to be able to
login. There are 2 user accounts set up on a WinAQMS Mini DAS, the Administrator
account and the WinAQMS Mini DAS account. The passwords for these accounts are
case sensitive and are as follows.
Username: administrator
Password: ecotech
Username: winaqms
Password: ecotech
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WinAQMS Mini DAS SECURITY
WinAQMS Mini DAS can be used to restrict access of certain users by setting
usernames and passwords (see “Security” in section 4.8). The default user access level
is 70 (full access) and the username and password for WinAQMS Mini DAS is:
Username: WinAQMS Mini DAS
Password: ecotech

1.2 Software Protection Device
WinAQMS Mini DAS also comes with a software protection device (or “dongle”)
which plugs into a USB port (or a parallel port on older loggers) on the DAS. The
dongle must be plugged in to the USB (or parallel) port for the software to function
correctly. If the user has a WinCollect dongle it can be used to run WinAQMS Mini
DAS Client software.

Figure 2: WinAQMS Mini DAS USB dongle

1.3 About This Manual
This manual is intended to serve as a guide to the most used features of WinAQMS
Mini DAS. We strongly recommend that you read this manual before using
WinAQMS Mini DAS to gain an understanding of its capabilities and operation.
As we are always trying to improve our products we welcome any feedback that you
might have with respect to this software. If you find any omissions or any errors in
this manual or with the software please email us at
WinAQMS Mini DAS.Feedback@ecotech.com.au
Throughout this manual there will be words printed in italicized text. These words
refer to parts of the WinAQMS Mini DAS software, such as menu items and field
names.
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1.4 WinAQMS Mini DAS Architecture

Figure 3 The WinAQMS Mini DAS architecture

WinAQMS Mini DAS has been designed as a client/server program. This means that
WinAQMS Mini DAS has two parts: the client and the server. The server handles all
the communication between the DAS and the analysers, recording of data and
starting/stopping of calibrations. The client is concerned with giving the user access to
settings and data. On its own the server has no user interface and there is no way you
can interact with it using the mouse or keyboard. The client is the visual interface of
WinAQMS and communicates with the server by requesting information or receiving
information that it has asked for at a prior time. This arrangement means that the
WinAQMS server must always be turned on before the WinAQMS client program
can connect to it.

1.5 WinAQMS Mini DAS agent
The WinAQMS agent allows the user to activate or deactivate individual components
of WinAQMS Mini DAS. The current status of each component is shown across the
top, underneath each component heading. The agent works on a simple start/stop
method where pushing the button underneath the status will either turn on (green
arrow) or turn off (red square) that program.
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Figure 4 WinAQMS Mini DAS Agent interface

Client
The Client is the user interface that is used to view data and alter the setup of the DAS
components.
Server
WinAQMS Server is the engine of the WinAQMS Mini DAS program, it requests,
logs and stores data from the external instruments as well as sending data to the
Client.
Data Server
The Data Server is the part of the WinAQMS Mini DAS that listens for data requests
from collection software and responds to the command with the appropriate data.
Data Pusher
The Data Pusher is used to upload data to an FTP site without the need for a request.
The Data Pusher requests data from the Data Server for a defined time period and
automatically uploads the data file to the selected FTP site.
Service
WinAQMS Mini DAS service is used to monitor the Server, Data Server, Client and
Data Pusher to ensure they are all running. If there is a problem with one of these
applications then the Service module will restart it.
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Installation and Setup

2.1 Setting up users and permissions in Windows 2000/XP
Only user accounts that have been granted the required permissions can run
WinAQMS Mini DAS. Users can be added from the local domain (the domain local
to the WinAQMS Mini DAS) or from an external domain administered by a domain
controller server. WinAQMS Mini DASs come with two users set up (the
Administrator and WinAQMS Mini DAS users) on the DAS and WinAQMS Mini
DAS installed and operational.

2.1.1 Adding local users to the WinAQMS Mini DAS
Log in to the DAS as administrator or someone with administrator privileges. Go to
the Control Panel and double click on User Accounts as shown in Figure 5. Within
this new window select the New Account link and create a name for the account in the
appropriate field. Once this is done select the administrator button and press the
Create Account button.

Figure 5 The Control panel

2.1.2 Giving the WinAQMS Mini DAS user permission to log on as
a service
1. In "Control Panel" open "Performance and Maintenance"
2. Click on "Administrative tools" and open "Local Security Policy"
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3. In the "Local Polices" section double-click on "User Rights
Assignment"
4. Find "Log on as a service" and double click on it.
5. Click on "Add User or Group", click on "Advanced", click on
"Find Now"
6. Select the WinAQMS user from the group then click on "OK",
click on "OK" and click on "OK" again.

2.2 Setting Windows XP to accept dialup connections
Windows XP can be set to automatically answer a dialup connection request through
a modem, but a modem must be installed on the WinAQMS Mini DAS to allow this
to occur. To accept incoming connections click on Start, Settings, Control Panel. This
will open the control panel window. Double click on the Network and Dial-up
Connections (Network Connections in Windows XP) and then on Make New
Connection (New Connection Wizard in Windows XP). The Network Connection
Wizard will start. Click on Next to proceed with making a new connection. In the
Network Connection Type window choose Accept Incoming Connections (or Set up
an advanced connection, hit next, then choose Accept Incoming Connections in
Windows XP) as shown in Figure 6 below and click on Next.

Figure 6 Adding a modem dialup support to Windows 2000.

You will then see a window similar to Figure 7 below asking you to choose the device
to accept the incoming connection. Choose the modem you have installed and click on
Next.
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Figure 7 Selecting the incoming connection modem

The next window will ask about Virtual Private Connections. Do not allow virtual
private connections to the DAS and click on Next. Select the WinAQMS user account
and any others you want to be allowed to log in using a dialup connection by placing
a tick in their selection box as shown in Figure 8 below.

Figure 8 Selecting the incoming connection users

Note: Only the users on this list will be able to establish
a dialup connection to this DAS. By default WinAQMS
Mini DASs are set to allow dialup connections. These
users must also be able to access the shared Database
directory.

In the Networking Components list make sure that Internet Protocol (TCP/IP) is
selected, then highlight it and click on properties (Figure 9).
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Figure 9 Setting the incoming connection properties

In the TCP/IP properties window select the specific TCP/IP addresses and set the
range from 192.168.0.1 to 192.168.0.10 as shown in Figure 10. Click OK and then
Next.
All that remains is for the Incoming connections to be named and then the process is
finished.

Figure 10 Setting the incoming connection IP addresses.
Note: The TCP/IP range 192.168.X.X (also 10.X.X.X)
will not appear on the internet and can be safely used
for local area networks. When dialing in to a WinAQMS
Mini DAS it will always assign itself the IP address
shown in the “From” field of Figure 10.

Go to the Control Panel and double click on Users Accounts as shown in Figure 5.
Click on the Advanced tab, click Advanced in the Advanced User Management. In
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the Local Users and Groups window click on Users and go up to Action and select
New User. Set the User Name to be WinAQMS Mini DAS (or another account name
that you want to use to run WinAQMS Mini DAS), type in a password and remember
it. Remove the tick in the User Must Change Password at Next Logon and add a tick
to the Password Never Expires option. Click on Create and then close the box. Open
the Control Panel again and double click on Users Accounts shown in Figure 5. Click
on the Users tab, select the WinAQMS Mini DAS user and then click on properties.
Select the Group Membership properties and give the WinAQMS Mini DAS account
Standard User access. Click on the Apply button and close the Users and Passwords
box.

2.3 Connecting a Remote Client to a WinAQMS Mini DAS
A remote WinAQMS Mini DAS client is able to connect to different WinAQMS Mini
DAS servers (a compatible server/client version is required). In this way a single
computer with the WinAQMS Mini DAS Client software installed can oversee the
operation of multiple mini DAS. If WinAQMS Mini DAS is started using the start
menu or a standard shortcut it will attempt to connect to a running WinAQMS Mini
DAS Server process on the local computer. If you want to connect to a DAS using a
dialup connection or if you want to connect to different WinAQMS Mini DAS you
need to enter a special command line when starting WinAQMS Mini DAS so that it
gives you a choice of DAS to choose from. To do this click on Start, then Run. Delete
any text in the box and replace it with the following line (including quotes).
“C:\Program Files\WinAQMS\Client\WinAQMSClient.exe” /ask
Then click on OK. This will tell the WinAQMS Mini DAS Client software to start in
a mode where it waits for a connection request from the user before it tries to connect
to a remote server. WinAQMS Mini DAS will start up and display a window similar
to Figure 11 below;

Figure 11 Connecting to a Remote WinAQMS Mini DAS

Figure 11 shows that the WinAQMS Mini DAS client can be set to connect to
multiple WinAQMS Mini DASs.
o The ID field is used by WinAQMS Mini DAS to uniquely identify loggers.
o Logger Name/IP is the logger‟s network name or IP address.
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o Dial-up Connection is a dropdown list which allows the user to specify which
dial-up connection to use to make a connection to the DAS.
o Dial on start-up allows the user to tell WinAQMS Mini DAS whether it should
try to establish the dial-up connection automatically. If the Connect button is
used then the WinAQMS Mini DAS client will attempt to connect to the
currently selected server using the specified Dial-up connection even if the
Dial on start-up checkbox is not set.
In Figure 11 there is Local, Ooze Lake and Smokey Hollow servers listed. The Local
DAS uses the loop back address (127.0.0.1) and will be located on the same computer
as the client software. The Ooze Lake logger has an IP address of 192.168.0.1 and the
WinAQMS Mini DAS client software will establish the Hong Kong dialup connection
(using the entered Username, Password and Domain) before attempting to connect to
the logger when the Connect button is pressed. The Smokey Hollow logger with IP
address of 10.0.0.1 will use the Perth VPN dialup connection when connect is
pressed.
The Dial on Startup checkbox is used by WinAQMS Mini DAS to determine if a
dialup connection should be established if it is started and the /ask command line
option is not used. If the Smokey Hollow logger was the last logger connected and
WinAQMS Mini DAS was started without the /ask command line option then the
WinAQMS Mini DAS client would try to connect to the Smokey Hollow logger at IP
address 10.0.0.1 using its currently active dialup/LAN connections. If the Ooze Lake
logger was the last logger connected to and WinAQMS Mini DAS was started
without the /ask command line option then the WinAQMS Mini DAS client would try
to connect to the Ooze Lake logger at IP address 192.168.0.1 by first establishing the
Hong Kong dialup connection.
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General Information

The Main screen of WinAQMS Mini DAS contains a plain background with 5 menus
on the top toolbar as seen in Figure 12. The file menu and Help menu are accessories
for use of WinAQMS Mini DAS and are briefly described here; the File, View and
Manual menus are most comprehensively used within WinAQMS Mini DAS and will
be individually discussed in the following three sections.
USING WINAQMS MINI DAS
Several parts of the WinAQMS Mini DAS interface do not change in appearance.
This section details these parts and how they work.
Like most Windows based software,
WinAQMS Mini DAS has a menu system
that allows you to activate the desired part
of the program from a set of options. Use
the mouse to access a menu bar item by
left clicking on the required menu heading,
then on the required menu bar item. Menu
bar items can also be accessed by using the
keyboard.

Figure 12 Menu shortcuts

When the ALT key is hit you will notice that the shortcut key for each menu item is
underscored. As you navigate further into the menu structure the shortcut key for each
menu item is also underscored, as shown in Figure 12. For example, instead of using
the mouse to open the Edit menu you can hit the ALT key and then press the E key.
Hit the A key and the Analyser Parameters window will load in the same way as if
you had used the mouse.
There is a set of Buttons just under the menu bar. These allow quick access to
commonly used parts of WinAQMS Mini DAS (Figure 13).

Figure 13 Menu Buttons

For example, if you click on the Analyser Parameters button the Analyser Parameters
window will load just as if you had used the menu bar or the keyboard shortcuts.
To close a window click on the small button with the cross in the top right hand
corner of the window or on the OK or Cancel buttons that appear on the window.
Clicking the OK button on any window in WinAQMS Mini DAS it will save any
changes that you have made and close the window. Clicking Cancel will discard any
changes then close the window. Clicking the close button in the top right hand corner
of a window will give the same result as clicking the cancel button. Not all windows
in WinAQMS Mini DAS have OK and Cancel
buttons but all windows have the close button in the
Figure 14 Minimise and Maximise
top right hand corner.
buttons

Many windows also have minimise and maximise
buttons as shown in Figure 14. The Minimise button
Figure 15: Minimised form
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will reduce the window to become like Figure 15. To restore the window to its
original size, hit the Restore Up/Down button (the left button in Figure 15) and the
window will return to its original size. The Maximise buttons in Figures 25 and 26
will increase the size of the window to fill the whole WinAQMS Mini DAS screen
except for the toolbar and the menu buttons.
Figure 16 shows a
maximised
Instantaneous Graph
window. It occupies
the entire WinAQMS
Mini DAS screen
except for the top
menu bar and buttons
and the status bar at
the bottom. Only one
window
can
be
maximised at a time
and is displayed in
Figure 16 Maximised form
front of the other
windows. This means
that when a window is maximised it is the only visible window. In Figure 16 clicking
on the Graph Settings button will open the Graph Settings window and reduce the
Instantaneous Graph window to the size it was before it was maximised.
The Instantaneous Graph, Historical Graph, Historical Data and Wind Speed and
Direction windows all resize their visual aspect to match their size. For example,
resizing the wind speed and direction window will cause the compass to resize itself
to match the size of the window.
WinAQMS Mini DAS has a comprehensive online help menu which can be accessed
by hitting the F1 button on the keyboard when the relevant screen is being displayed.
For example if you want to know more about the system parameters options then open
that window up and hit the F1 key. A help screen will appear which has information
about the system parameters.
The three main menus used in WinAQMS Mini DAS are the Edit, View and Manual
menus which will now be outlined in greater detail.
FILE MENU
The file menu contains menu objects that are concerned with the settings of the
overall program. These include changing the grey background to a customised
picture, saving or loading the configuration of WinAQMS Mini DAS or exiting the
program.
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HELP MENU
The Help menu contains three help menu
items Contents, Index and Introduction to
WinAQMS Mini DAS all access the online
help file (Figure 17). Contents can be used to
get help on topics; Index can search the help
file for specific words and Introduction to
WinAQMS Mini DAS goes through an online
version of the example in this manual.
Figure 17 Help index.

The Help, About WinAQMS Mini DAS window
shows important legal information concerning
the licence agreement and warranty of
WinAQMS Mini DAS and also shows the
version number of WinAQMS Mini DAS that
is running (Figure 18).

Figure 18 About WinAQMS Mini DAS.

Registered Users shows information
about who WinAQMS Mini DAS is
registered to, the date of production, how
many users are allowed to use the
software at the same time and the
Ecotech Identification number for the
software (Figure 19).

Figure 19 Registered User Details
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Security
WinAQMS Mini DAS can be set to require a username and password to be entered
before access to the system is enabled. Users in WinAQMS Mini DAS have a
username, password and a security level. Usernames and Passwords can be up to 32
characters in length and are case-sensitive. Figure 20 below shows the User List
options when a user with the highest security level (70) has logged into the system.

Figure 20 User List Window

The Enable Security checkbox will enable or disable security. Once enabled
WinAQMS Mini DAS will require users to enter a username and password into the
login box as shown below in Figure 21.

Figure 21 Login Window

Each user is able to change their own password (except for those with a security level
of 0). To change a password, double click on the user in the list or select the users
record and press the Change Password button. You will be prompted to enter the old
password, the new password and to confirm the new password. To change a users
security level highlight the user in the list and click the Change Security Level button.
If a user level less than 0, or greater than 70, is entered then the user security level
will not be changed.
A level 70 user can add new users, delete existing users, change the user levels and
change the password of other users without needing to know their passwords.
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The table below shows the user levels in WinAQMS Mini DAS and what operations
the level is permitted to perform. This lowest level is 0 and each higher level is
permitted to do everything the previous level could in addition to what is listed in the
table.
User
Level
0

10
20
30
40
50
60
70

Security level description
No access to menu structure or buttons except the Security and Remote
Logger menu. Can view windows that open on startup but not move
them or change settings.
Can access any item in the View menu and move the windows around.
No settings can be changed.
Can open View menu windows and change the setting of the windows.
Can access the Edit menu items for viewing but cannot change any
settings.
Can Add/Edit logs, set precision values and set a channel out of service.
Can also access and use all Manual menu items.
Can change settings in the Edit menu, but not add or remove
channels/analysers.
Can add or remove channels/analysers.
Can add/remove other users and their passwords. Can also enable/disable
security.

The default user access level is 70 and the username and password for
WinAQMS Mini DAS is:
Username: WinAQMS Mini DAS
Password: ecotech
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Edit Menu

The Edit menu allows the user to enter the specifications for running the program.
These specifications include the parameters for the DAS and analysers, calculated
channels for transformation of data, alarm generation and more.

4.1 System Parameters
The System Parameters window contains the basic DAS information and some of the
system-wide settings. Basic DAS information includes:
 ID, a text field for identifying the system.
 Company Name, a text field for recording the name of the company using the
system.
 Contact Person, a text field for recording the name of the person to contact
regarding the system.
 Site Name, a text field for recording the name of the system site.
 Notification Number, a text field for recording the telephone number to call if
faults occur.

Figure 22 System Parameters

System wide settings include:
 Language: The language listbox offers you the choice of what language you want
WinAQMS Mini DAS‟s text to be displayed in (English, Chinese, Spanish). If
there is only one language displayed (Australian English) then that is the only
language available to you. If a different language from the current language is
chosen and the OK button is pressed then WinAQMS Mini DAS‟s menu structure
and buttons will be changed immediately to the new language with the exception
of windows which are already open. If a window is open prior to a language
change then it should be closed and then reopened to allow it to properly update
its text and buttons.
 SMTP Server, the server name or IP address WinAQMS Mini DAS will use to
send emails if there is an alarm condition.
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Data File Prefix. The data that WinAQMS Mini DAS records is stored in ASCII
text files in C:\Data\<year>\<month>\ and are named with the data file prefix then
with a numeric <year><month><day>.waq. A new data file is made at the start of
each day so any change made to the Data File Prefix field will take affect at the
start of the next day of logging.
Secure Telnet Connection, Specifies whether a secure (encrypted) telnet
connection will be established between the WinAQMS Mini DAS client and
server.
Certificate Name, Within this field place the Certificate Name to allow the secure
connection to proceed. The Certificate name is taken from the digital certificate
which can be obtained by contacting Ecotech.
Note: To use the secure connection component of WinAQMS
Mini DAS the user must first contact Ecotech and arrange its
setup and receive a digital certificate. Securing connections
should only be used when necessary.

4.2 Analyser Parameters
The Analyser Parameters window contains all the settings for each analyser as well as
for any analogue or digital channels that are provided by those analysers. Any
communication settings, calibration settings and digital input or output settings can be
altered in the Analysers Parameters window.

Figure 23 Analyser Parameters

The Analyser list box at the top of the window contains a list of all the analysers
currently in the WinAQMS Mini DAS system. Changing between different analysers
in the system using this list box will alter the information in the tabs to match the
chosen analyser. The options available in the tabs and the number of tabs will change,
depending on the analyser. E.g. for an Ecotech Termination Panel the Digital Input
Settings and Digital Output Settings tabs will appear, but a R&P Teom 1400a analyser
has no digital inputs or outputs so the corresponding tabs will not appear.
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Clicking on the Add New Analyser button will add a new analyser to the system,
which will default to an Ecotech Termination Panel (TP) with no channels configured
and default communication settings. The Delete Analyser button will delete the
currently selected analyser from the system including any channel configurations it
has. The OK and Cancel buttons function as described earlier, except that clicking the
OK button will also restart the server to reflect any changes.

4.2.1 Information
When opened, the Analyser Parameters window will display the Information tab for
the first analyser in the system. Figure 24 shows a typical opening screen for an
Ecotech Termination Panel. Entries can be made in the following fields:
 The Label text box allows you to enter a label that will help you to identify the
analyser.
 The Manufacturer list box shows the names of manufacturers of analysers which
WinAQMS Mini DAS supports.
 The Model list box shows the analyser models corresponding to the Manufacturer
list box that WinAQMS Mini DAS supports. The image to the right changes to
match the selected model.
 The Device ID is used by WinAQMS Mini DAS when communicating with the
analyser. It also identifies an individual analyser when several analysers are multidropped (that is, communicating on the same serial port).
 Data Request Period (sec) is the time in seconds between requests for data made
by WinAQMS Mini DAS to the analyser.
 Maximum Response Time (sec) is the time in seconds that WinAQMS Mini DAS
will wait for the analyser to respond. If this time passes with no response,
WinAQMS Mini DAS will set its data value for the reading to NULL. If
Maximum Response Time is set too low then the analyser will not have sufficient
time to respond in time so WinAQMS Mini DAS will report NULL‟s even if the
analyser is functioning normally.
 Request Delay (mSec) is the time in milliseconds that WinAQMS Mini DAS will
wait before issuing the data request to the serial port. This parameter is useful
when several analysers are being multidropped and analysers have a delay in
transmitting and receiving information.
 Analyser Description is a brief description of the function of the analyser model
selected.
For Opsis analysers there is no Device ID but there are Station # and Data Update
Timeout fields. The Station # field should be set according to what is set on the Opsis
analyser. As the Opsis often will not update its data value the Data Update Timeout is
used as the length of time (in MM:SS format) to keep using the last valid data value
before setting the current data to a null value.
For Thermo Environmental analysers the Device ID field becomes a dropdown list for
the common Thermo Environmental analyser types of 42C (ID 170), 43C (ID 171),
48C (ID 176) and 49C (ID 177) as well as an Other list item for Thermo
Environmental analysers that use ID‟s other than the ones listed.
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Below are the suggested Device ID and Max Response Time settings for various
analysers.

Table 1 : Suggested Device ID's and Maximum Response Times for analysers.

Manufacturer

Model

Device ID

Maximum
Response
Time
(seconds)

Request
Delay
(millisecond
s)

API
Dani

AMX Series
TNMH 462

1
1

0
0

Ecotech

98XX series
Serinus series

1
None
Required
10, 11, 20 ,
30, 41, 42, 50
depending on
analyser
0 unless
multidropping

1

0

1

0

None
Required
0
corresponds
to an ID of A
1
0
None
required
41, 42
10, 11, 20 ,
30, 50
depending on
analyser
None
Required
4

1

0

1

0

1
1
1

200
0
0

3
2

0
0

3

0

1

0

0
None
required
170, 171,
176, 177 or
other
1 if required
None
Required

1
1

0
0

1

250

1
1

0
0

Environnement
SA
Gill

ICP DAS
LN Industries
Met One
Monitor Labs

Opsis
Rupprecht and
Patashnick
Synspec
Teledyne

M9003, GasCal
1000, Termination
Panel
AC31M, AF21M,
CO11M, O341M
WindObserverII,
WindSonic
I-7024
Sonimix 3080
E-BAM
BAM 1020
9841, 9842
98XX

AR600, AR650,
LD500
Teom 1400a
GCx55
M700

Thermo
Environmental

42C, 43C, 48C, 49C
and others

Vaisala
Verewa

PTB220, WS425
F-701
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4.2.2 Communication Settings
The Communication Settings tab shows the settings WinAQMS Mini DAS is using to
communicate with the selected analyser.
o Connection Type list box shows whether the connection to the analyser is
Serial RS232 or U.S.B. (Universal Serial Bus).
o Serial Port list box shows all serial ports which WinAQMS Mini DAS finds
on the system
o Baud Rate shows a list of communication speeds ranging from 110 to 256000
baud
o Data Bits can be from 4 to 8
o Parity can be even, mark, none, odd or space
o Stop Bits can be 1, 1.5 or 2. Most analysers have 8 data bits, no parity and 1
stop bit.
Whenever possible an analyser should be set up with the maximum possible baud rate
to ensure the fastest possible communication between the DAS and the analyser.
WinAQMS Mini DAS can communicate with Ecotech EC98XX/Serinus series
analysers via a U.S.B. type A or type B cable. If a U.S.B. connection is selected a
dropdown list of U.S.B. analysers connected to the DAS will be displayed.

Figure 24 Communication Settings in Analyser Parameters
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Table 2 Suggested Communication Settings for analysers.

Manufacturer

Model

Parity

Stop Bits

API (Teledyne)
Dani
Ecotech

AMX Series
TNMH 462
EC 98XX, Serinus
and Aurora series
Termination Panel,
GasCal 1000 (Gas
Calibrator)
AC31M, AF21M,
CO11M, O341M
WindObserverII
(Wind)
I-7024
E-BAM
BAM 1020
ML 98XX Series
AR600, AR650,
LD500
Teom 1400a

9600
9600
38400

8
8
8

None
None
None

1
1
1

4800

8

None

1

9600

8

None

1

9600

8

None

1

9600
9600
9600
9600
9600

8
8
8
8
8

None
None
None
None
None

1
1
1
1
1

9600

8

None

1

M700
42C, 43C, 48C,
49C and others
PTB220, WS425
F-701

9600
9600

8
8

None
None

1
1

9600
1200

8
8

None
None

1
1

Environnement
SA
Gill
ICP DAS
Met One
Monitor Labs
Opsis
Rupprecht and
Pertashnick
Teledyne
Thermo
Environmental
Vaisala
Verewa

Baud Rate Data Bits

Wherever possible WinAQMS Mini DAS handles the special communication
requirements of analysers in software. For example the TEOM 1400a Particulate
Monitor normally requires a special cable but this is handled in software with special
communication settings so that a standard serial cable can be used.
Note: The Monitor Labs 98XX Series of analysers have a
default baud rate setting of 2400 baud. If you set
WinAQMS Mini DAS to communicate with a Monitor Labs
98XX analyser at 9600 baud then you must ensure that the
Multidrop baud in the Interface menu of the analyser is set
to 9600 baud.
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4.2.3 Channel Information

Figure 25 Channel Information in Analyser Parameters

The Channel Information tab allows configuration of the input data channels for the
analyser. To add a channel to the system click on the Add Channel button. To remove
a channel, highlight it by clicking on the grey block at the left end of the channel row
and click on the Delete Channel button. Multiple channels can be highlighted and
deleted at the one time. The fields present in the Channel Information tab includes
those listed below:
 System Channel #: the unique number that WinAQMS Mini DAS uses to identify
the channel. This number can be changed but must be unique.
 Label: allows you to enter a label to easily identify the channels in other parts of
WinAQMS Mini DAS.
 Analogue Input #: the physical channel number on the analyser. For a Teom
analyser the Analogue Input # field is replaced by a PRC# field, which allows you
to specify certain register numbers in the Teom analyser.
 Analogue Output #: Choose from four channels where voltage output signals will
be sent from (ICP DAS only).
 Multiplier and Offset: Every time a reading is taken the value is multiplied by the
value in Multiplier and has Offset added to it (in that order).
 Units: is an editable list which shows the units of the channel data. If you do not
find the appropriate unit in the dropdown list then you can edit the Units box and
enter the unit you require. Superscript and subscript characters can be entered
using the Windows Character Map utility which can be found in Start, Programs,
Accessories, System Tools, Character Map.
 Decimal Places: When the data is displayed the number digits to the right of the
decimal place will match the number in the Decimal Places column.
 High Alarm and Low Alarm: show the values at which WinAQMS Mini DAS will
label the status of the data as being in high or low Alarm. Setting both high and
low alarm values to 0 will disable the alarms for that channel. Data must first
qualify as „Good‟ (that is, the percentage of readings that were valid exceeds the
value in the System Parameters window) before it can be marked as in high or low
alarm.
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Alarm Number: refers to the alarm that is triggered when the channel enters a high
or low alarm condition. One alarm number can be used for many channels.
Valid Data High and Valid Data Low: show the values at which WinAQMS Mini
DAS will label the status of the data as being bad. Setting both values to 0 will
disable the valid data limits. Data that is labelled as bad will not be included with
other valid readings in a data average labelled as „Good‟.
Channel Type: Each channel has a Channel Type, which can change depending on
the type of analyser. For example the Ecotech EC/ML 9841 nitrous oxide
analysers respond with data for NO, NOX and NO2 when a data request is made
but the channel can only store one of the three values passed to it. Specifying one
of NO, NOX or NO2 tells WinAQMS Mini DAS which part of the data returned
that you want. The Voltage type is the default value and is used if there is no need
to signal to the analyser that WinAQMS Mini DAS wants data specific to a
particular channel type, register etc.
Table 3 Channel types and the analysers that use them.

Channel Type
Voltage
Frequency
Counter
NO

Concentration
Deviation
Light Level
Logger
CH4
NMHC
THC
H2S
TRS
O3
CO
NH3
SO2
Nx
WS

Manufacturer
Default
Ecotech
Ecotech
Ecotech, Monitor Labs,
API, Environnement SA
Ecotech, Monitor Labs,
API, Environnement SA
Ecotech, Monitor Labs,
API, Environnement SA
Opsis
Opsis
Opsis
Opsis
Dani
Dani
Dani
API
API
API, Environnement SA
API, Environnement SA
API, Ecotech, Monitor Labs
API, Environnement SA
Ecotech, Monitor Labs
Gill, Vaisala

WD

Gill, Vaisala

NO2
NOX
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Model
Default
Termination Panel
Termination Panel
9841, AC31M, AMX
Series
9841, AC31M, AMX
Series
9841, 9842, AC31M,
AMX Series
AR600, AR650, LD500
AR600, AR650, LD500
AR600, AR650, LD500
AR600, AR650, LD500
TNMH 462
TNMH 462
TNMH 462
AMX Series
AMX Series
AMX Series, O341M
AMX Series, CO11M
AMX Series, 9842
AMX Series, AF21M
9842
WindObserverII,
WindSonic, WS425
WindObserverII,
WindSonic, WS425
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Process: The Process field determines what mathematical property of the data
received over the average period will be stored. Options include: Average
(default), Max (maximum value), Min (minimum value), Total (the sum of all the
readings received on that channel) and Std Dev (standard deviation).
Description: is a fifty-character text field. This field is used to more fully describe
a channel if the Label is insufficient
Percentage Ok: the percentage of data that must be valid before WinAQMS Mini
DAS will mark a report as being OK. If a value of 60 is entered here then if there
is a problem with over 40% of the data readings the report will have a bad status.
Log Report 1, 2, 3, 4: determines whether the channel data will be recorded in the
database for the selected report. If not ticked, the channel will still request data but
there will be Null data recorded in the database. If all four of the Log Report
options are not ticked for a channel then that channel will have no entry at all in
the database.
Out of Service: If a channel is marked as being Out of Service then the channel‟s
data will still appear in the database but its‟ status will indicate that the channel is
out of service.
Serial Port Output: specifies whether data for the channel will be included in the
string of data averages which is sent to the serial port specified by Report Settings.
Alternate File Output: specifies whether data for the channel will be included in
the data averages stored in alternative data files.

Different Analyser types will have different fields available in the Channel
Information tab. The differences are listed below.
 Ecotech EC/ML 98XX, 9841, 9842, API, Dani, Environment SA and Teco
analysers do not show the Analogue Input # field.
 The Digital Input Settings and Digital Output Settings tabs will only appear for
the Ecotech Termination Panel (TP) and Ecotech EC/ML analysers.
 Opsis analysers have a Gas# and a Path # field instead of an Analogue Input #
field.
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4.2.4 Calibration Control
The Calibration Control tab shows the signals that the digital output channels and
calibrators are set to when the channels of the selected analyser enter the span, zero
and stabilisation periods of their calibration sequence. Each row (point) of the grid
matches a part of a sequence occurring within the analyser. Measurements are only
taken during the Span and Zero cycles, the stabilisation point is a recovery cycle.

Figure 26 Calibration Control in Analyser Parameters

Point:
Label:
Point type:

Duration:

This is one part of a sequence of events that are
performed during a calibration
This is the name you give a specific point so
that it is instantly recognisable and unique
The drop down field contains the name of the
process that the point will perform (span, zero,
stabilise)
This is the length of time that each point will
perform there function (minutes)

Average duration
(min):
This is the length of time that the measurement
will take place and is displayed as a average
over that time i.e. if set to 2 as in Figure 26 then
readings will be taken over minutes 18 to 20
and the average measurement over this time
will be recorded.

Extra fields
Digital Outputs
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Instruments:
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These fields are used when sending digital
signals to the instrument. The digital signals
can be set to either high, low or empty and
should match up to the requirements of the
instrument (see section 6.3 Communicate with
Analyser). Click repeatedly on the cells to
change their values.
Instruments that are being used for calibrations
can appear in this section (9830, 9841 etc) these
fields should have the function being performed
to them at this specific point.

4.2.5 Digital Input and Output settings
The Digital Input Settings (Figure 27) and Digital Output Settings (Figure 28) Tabs
show the digital input and output points and their settings for the currently selected
analyser. The High Value and Low Value fields show the value that is recorded into
the database for the digital input and output channels when they are high or low; all
other fields have the same function as described in Channel Information. The Add
Digital Input/Output buttons and the Delete Digital Input/Output buttons also function
identically to the Add Channel and Delete Channel buttons in Channel Information.

Figure 27 Digital Input Settings in Analyser Parameters

The Default Output field in Digital Output Settings is the value that the digital output
is set to when WinAQMS Mini DAS is started.
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Figure 28 Digital Output Settings in Analyser Parameters

4.3 Calculated Channels

4.3.1 Calculated Channels
The Calculated Channels tab
on the Calculated Channels
window allows you to create
new channels that perform
scalar calculations on the
data in existing channels.
All the fields in the
Calculated Channels tab
have the same function as in
the Channel Information tab
of the Analyser Parameters
window, except for the
Figure 29 Calculated Channels
Calculation field. This field
is where you enter the calculation you want the channel to perform. The calculation
refers to system channels with the text CX, where X is the system channel number. In
Figure 29, for example, a calculated channel determines the temperature in Kelvin
using the calculation <C1 + 273>, where channel 1 contains the temperature data in
degrees Celsius. The Process field works on the data after the calculation has finished.
Note: If a source channel is using a maximum,
minimum, standard deviation or total process the
calculated channel will use the instantaneous
data values for those channels not the maximum,
minimum, standard deviation or total for the
average period.

Below the table of calculated channels is a dropdown list box and a button. The
dropdown list will show all the calculated channels and clicking on the Auto-Test
Channel button will run the calculation for the channel in the dropdown list box with
the channel value entered in the Test Value box. Each occurrence of a channel, CX,
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will be replaced with the number in Test Value. The results of the calculations are
reported in the text box at the right. If there was an error produced when a calculation
was performed then the result text box will include a line similar to <Problem found
with calculation for channel value of X>.
The following operators and functions can be used:
Arithmetic operators: +, -, *, /, and brackets ().
Logical operators: =, < (less than), > (greater than), <> (not equal), >= (greater than or
equal), <= (less than or equal), NOT, AND and OR which all evaluate to –1 if true or
0 if false.
Trigonometric operators: SIN, COS, TAN and ATN which have radian operands and
results.
Mathematical operators: SQR (square root), EXP (natural exponent), LOG (natural
log) and ^ (power). The constant for NULL can be included in a calculation.
WinAQMS Mini DAS evaluates NULL to a numerical value (1.79769313486231E+308) that it recognises as a NULL data reading.
Example: if you want a channel to have a result of 10 if channel 22 is under 800 units
or over 900 units and a value of 5 if channel 22 is between 800 and 900 units, then
you would use a calculation like the following.
-10 * ((C22 < 800) OR (C22 > 900)) -5 * ((C22 >= 800) AND (C22 <= 900))
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4.3.2 Vector Averaged Channels
The second tab on the Calculated Channels window allows you to find the vector
average or the sigma theta of vector data which is often used for wind data. Since
each channel, however, can only record scalar (non-vector) data, to calculate a vector
average two channels must be set up, one to find the magnitude and the other the
direction of the vector average.

Figure 30 Vector Averaged Channels in Calculated Channels

Figure 30 shows an example of this. The wind speed and direction channels are
numbers 13 and 14 respectively. Having Magnitude Channel ticked means that
channel 100 will store the magnitude of the vector average. Channel 101, meanwhile,
with Direction Channel ticked, will record the direction of the vector average and
channel 102 with Sigma Theta Channel ticked will record the standard deviation of
wind direction for channel 14.

4.3.3 Rolling Averages
Rolling average channels can be made by specifying an existing channel as the Source
Channel and an existing report as the Source Report. The Rolling Count indicates how
many times the channel will roll the specified report. For example, if report 1 was
averaged every 5 minutes and report 2 was averaged every hour and an 8 hour rolling
average of 1 hour data was required then the Source Report value would be set to 2
(report 2), the Rolling Count would be set to 8 (8 hours).
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Figure 31 Rolling Average Channels in Calculated Channels

4.4 Report Settings
The Report Settings menu allows you to change the reporting period of any of the four
reports which WinAQMS Mini DAS supports as well as setting whether reports are
written out to a serial port or to an alternative data file.
o Period can be altered with the up and down arrows used to increase or
decrease the report period value.
o Units this field indicates the units of time associated with the period filled in
above. The time unit can be minutes, hours or days.
o File: this check box determines whether the averages for all channels are
written out to the data files.
o The Port check box indicates whether the report is to be sent to a serial port. A
report is output to the listed serial port immediately after the report is written
to the data file.
Note: If the port option is not checked then all of the fields
Port#, Format, Baud Rate, Data Bits, Parity, Stop Bits and
Handshaking will be hidden. All of the previously listed fields
except for Format are settings for the serial port and should
be set as appropriate to communicate with the receiving
system.

o The Alternate File check box indicates whether a secondary data file will be
produced in the specified format. The Format field indicates the type of text
(or other) formatting that the serial output report will take (for more detail see
APPENDIX D).
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Figure 32 Report Settings

The Alternate File Frequency field has 2 options, Daily and Report.
Daily
This will make a data file for each day in the C:\data directory with a name in the
format
<PPP><RRR><YYYYMMDD>.txt
where
PPP - is the data file prefix (1 to 3 character length)
RRR - is the report number (3 character 0 filled)
001 = report 1
002 = report 2
003 = report 3
004 = report 4
128 – 143 = span report 1-16
144 = zero report
160 -175 = precision report 1-16
YYYYMMDD - date of the data readings
Report
This will make a new data file every time report data is ready in the C:\data directory
with a name in the format
<PPP><RRR><YYYYMMDDHHNNSS>.txt
where
PPP - is the data file prefix (1 to 3 character length)
RRR - is the report number (3 character 0 filled)
001 = report 1
002 = report 2
003 = report 3
004 = report 4
128 – 143 = span report 1-16
144 = zero report
160 -175 = precision report 1-16
YYYYMMDDHHNNSS – date and time of the data reading
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4.4.1 Alarms
The Alarms window sets any digital outputs, emails and WinCollect alarms that get
sent when a channel in WinAQMS Mini DAS triggers an alarm. A channel triggers an
alarm by either going above the High Alarm Value or below the Low Alarm Value.
Report alarms are triggered by the values of reports. Instantaneous alarms are
triggered by the instantaneous data values received from analysers.
Both windows are presented in the same format being made up of at least 7 fields and
is shown in Figure 33.

Figure 33 Alarms

o Alarm # : This field is used to identify the alarm.
o Digital Outputs # : The four Digital Output fields specify which digital output
gets set to either Hi, Lo or not changed (blank).
o Send Email sets whether WinAQMS Mini DAS sends an email when the
alarm is triggered.
o Reoccurring Emails sets whether WinAQMS Mini DAS will continue to send
new emails if a channel stays in the alarm state.
Note: If a channel enters its alarm state and the Send
Email field is set a single email will be sent. If a
channel stays in the alarm state at the time of the next
report (or the next instantaneous data reading) a new
email will not be sent unless the Reoccurring Emails
field is set.

o Min Time Between Emails is the minimum time in hours, minutes and seconds
between an email being sent for that alarm.
Note: If a channel enters an alarm state and the Send
Email and Reoccurring Email fields are set then a new
email will be sent only if the time in Min Time Between
Emails has passed since the time the last email was
sent.

o The Email Details View/Set button will open up a window as shown below in
Figure 34.
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Figure 34 Alarm Email Details






The To field is the email address that the alarm email should be
sent to. From is where the email will say it is from.
Subject is the subject of the email message.
Attached is the path and name of any files that are to be attached to
the alarm email message. (This should be a comma delimited list of
valid paths and filenames on the logger.)
The large open text box is for the text of the email message.

o Send Alarm: When an alarm condition is met and the Send Email option is set,
WinAQMS Mini DAS will send an email using the SMTP server that has been
set in the SMTP Server field in System Parameters (Section 4.1). The email
will automatically include an additional short text message describing what
alarm has been triggered and when it happened in addition to the text in the
box (which will follow the message).
o The Alarm Details View/Set button will open up a window similar to the one
shown below.

Figure 35 Wincollect Alarm
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Wincollect workstation through a network then a dialup connection
needs to be used.
The Username and Password fields are for the username and
password required by the dialup connection.


Note: If there is no Dialup Connection selected
from the dropdown list the Username and
Password fields will be hidden.




The Wincollect IP address field is the Wincollect workstations‟
TCP/IP address on the network. (LAN or dialup connection)
The Domain field is used if the Wincollect Workstation is part of a
domain but otherwise can be left blank.

4.5 Logs
WinAQMS Mini DAS has a Log feature which allows users to Log in all activity that
has been performed on or with the WinAQMS Mini DAS program to keep track of
work and changes performed.
1. Under the Edit menu select the Log menu item
2. On the main Log screen click the Add new log entry, a new
window will appear (Figure 36).

Figure 36 Log entry window

3.
4.

Within this new window choose the operator name if not already
present then enter a new name
In the blank white space type in the task being performed the press
ok, if you wish not to save/enter the log then press cancel.

The main Log screen contains a summary of Log entries. By default the Log screen
will record the last 10 log entries; more can be accessed by changing the Start
Date/time.
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Figure 37 Logs main screen

Start date time: Time from which logs are to be collected from. Default
is start of the 10 latest logs, this can be altered to
include more older logs by changing the start date
time.
End date time: Date up to which logs will be included. Default is the
following day to ensure most recent logs are included.
Ok :
Confirm log entries, must be pressed for any entries to
be confirmed and saved.
Load Log:
Loads all logs from within the time specified in the
start and end date/time.
Cancel:
Leave the window without saving changes

4.6 Display Schemes
Display schemes in WinAQMS Mini DAS save settings for the Instantaneous Data,
Instantaneous Graph, Instantaneous Wind Speed and Direction, Historical Data and
Historical Graph windows. A display scheme will remember your settings for each of
these windows. For example, the Default scheme will remember which channels you
have selected in the Instantaneous Data and Instantaneous Wind Speed and Direction
windows, the colours you have selected for the channels plotted in the Instantaneous
and Historical Graphs and all other settings you have chosen.
When you make a change to any of the
settings for these windows and close the
window a dialog box will appear as shown in
Figure 38. If you want to save the changes
made to the window then choose Yes. If you
Figure 38 Saving settings to a Display
do not want to save the changes to the
Scheme
window then choose No. If you do not want
to save the changes to the window and want
the window to remain open so you can make more changes then choose Cancel.
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When a window that uses a display scheme is closed or the WinAQMS Mini DAS
program exited, WinAQMS Mini DAS will remember the settings and display scheme
of the windows and will restore them exactly the same way they were before.
To add a display scheme enter the name of the new scheme into the text box to the
right of “New scheme name” as shown in Figure 39. If you want to copy the settings
from the display scheme shown in the dropdown box, then put a tick in the Copy
selected scheme checkbox and click Add. To delete an existing scheme, select it from
the dropdown list and click on Delete.

Figure 39 Adding a new Display Scheme

4.7 Remote Logger
The Remote Logger window shows a list of the remote data DAS connections.
Connections can be added by clicking on the Add button. Connections can be deleted
by highlighting the connection(s) and clicking on the delete button. A deletion
confirmation box will appear when deletions are made. A connection to a remote
DAS can be established by highlighting the required connection and clicking the
connect button. Once a connection is established the Connect button will become
inactive and a new connection cannot be made unless the current connection is
dropped.
The Connection Settings column shows the basic information about the connection. It
shows the connection type (TCP/IP or RS232) and basic settings related to the
connection. For TCP/IP connections it shows the IP address and port number. For
RS232 connections it shows the phone number, RS232 port number and baud rate.
Clicking on the Connection Settings button will open a second window which will
show the full details of the connection as shown in Figure 41 and Figure 42.

Figure 40 Remote Logger Window
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RS232 connection has the following fields
Phone #:
The phone number that will be dialed by WinAQMS Mini
DAS. If this field is empty then no phone number will be
dialed.
Modem Init String: This string command will be sent to the RS232 port prior to the
Phone # being dialed.
RS232 Port:
The port that will be used to make the connection.
Baud Rate:
The speed at which the RS232 port will be set to operate at.
110-256000 (9600 default).
Parity:
Space, Odd, None (default), Mark or Even
Data Bits:
4 to 8 (default).
Stop Bits:
1 (default), 1.5 or 2
Handshaking:
None (default), XOn/XOff, RTS/CTS or XOn/XOff+RTS/CTS

Figure 41 RS232 Connection Settings

TCP/IP connection has the following fields
Logger Name/IP:

The IP address or name of the DAS (192.168.0.1
default).

Dialup Connection:

This is a dropdown list of the dialup connections that
are set up on the DAS. The default is not to use a
connection.

Username and Password:

The username and password required to authenticate
onto the remote DAS.

Domain:

The name of the Microsoft Windows domain that a
DAS is connected to. If there is no domain then leave
this value as a *.

Telnet Port:

The port that the client will use to connect to the DAS
(32684 default).

Secure Telnet:

This checkbox allows you use a secure telnet
connection between the WinAQMS Mini DAS Client
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and Server. This option requires digital certificates that
have been issued by Ecotech Pty. Ltd.

Figure 42 TCP/IP Connection Settings

4.8 Security
The Security menu item is used to login, change passwords, add users and change
security levels (see the section “Security” on page 14).

4.9 Data Pusher
The Data Pusher is used to upload data to an FTP site without the need for a request.
The Data Pusher requests data from the Data Server for a defined time period and
automatically uploads the data file to the selected FTP site.

Figure 43 Data Pusher screen

General
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FTP Address:

URL or IP address of FTP server

FTP Username:

Username needed to logon to FTP server

FTP Password:

Password needed to logon to FTP server

FTP Remote Directory:

If data is to be located in subdirectories on FTP server
eg. Data

File Prefix:

Attaches character to the start of the filename to
differentiate data from different stations

Connect mode:

Choose between “Active” and “Passive”.
Active work by WinAQMS Mini DAS initialising a
connection to the FTP Server, the server then connects
to WinAQMS Mini DAS.
Passive works by WinAQMS Mini DAS initialising a
connection to the FTP Server which informs
WinAQMS Mini DAS of which port to connect to,
WinAQMS Mini DAS will then connect to the FTP
Server on the specified port.

Protocol
Implicit (Secure):

The FTP server defines a specific port for the client
(990) to be used for secure connections.

Explicit (Secure):

Uses the default ftp port (port 21)

Standard (Not Secure):

Standard port 21 with no security

Polling
Transfer Increment (mins): Number of mins between data transfers
Last Transfer:

The date of last transfer (this does not need to be set in
initial setup)

Next Transfer:

The date of the next transfer (this can be set in initial
setup or can be left)

Last Result:

A number indicating the status of the last result. i.e. 0
for success

Write data:

Choose either “Append” or “New File”.
Append will create a single file for each day and all
uploads from that day will be stored in this file.
New File will create a new file for every upload
(including the time in the filename) as defined by the
transfer increment value above.

Enabled:

40
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Note: WinCollect can import from the files that WinAQMS Mini
DAS pushes to. This eliminates the need for a static IP or a DNS
service

4.10 Data Server Settings
The data server settings window is used to specify the settings of the WinAQMS Mini
DAS Data Server. Programs such as Ecotech‟s WinCollect, communicate with the
WinAQMS Mini DAS Data server to retrieve data. This window contains four tabs
labelled Serial RS232 Settings, Protocol Settings, Telnet Settings and Modbus
Settings.

Serial RS232 Settings

Figure 44 Serial RS232 tab

This tab allows the user to enable a serial port that the WinAQMS Mini DAS Data
Server can communicate through; it also allows the user to specify the parameters of
this communication.

Protocol Settings

Figure 45 Protocol settings tab

This Tab allows the user to choose if they want to enable Indic or Zeno logger
emulation for the request of data from the Data server.
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Telnet Settings

Figure 46 Telnet Settings

The Telnet Settings tab sets the Port number which the data server will listen to for an
incoming connection. The First Telnet port is set to the default of 32683 where it
listens for valid data requests. The alternative port is set to a port number that the data
server will also listen to for valid data requests.

Modbus Settings

Figure 47 Modbus Settings

The Modbus settings tab allows the Modbus protocol to be enabled. The Modbus
protocol is an alternative protocol for the request and transfer of data. WinAQMS
Mini DAS acts as a slave to the requesting program and must have a unique slave
number to respond to appropriate requests for data. Modbus channels are different to
those in WinAQMS Mini DAS and within this window the Modbus channels can be
linked to their equivalent WinAQMS Mini DAS channels. Channels can be created
and deleted by using the two buttons near the bottom of the tab, the information sent
from WinAQMS Mini DAS can be transformed using the multiplier and offset fields,
and the data sent is specified to a certain report period.
Note: Leaving Multiplier as 1 and Offset as 0
will not perform any transformation to data.
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4.11 Stack sequencing
Stack sequencing allows WinAQMS Mini DAS to set digital outputs in a repeating
cycle. The cycle is made up of a series of points which will run through sequentially
and repeat continuously. The stack sequencing will be suspended when a calibration
is in progress.

Figure 48 Stack sequencing window

Channels: the channels that are selected here will be marked with a calibration state
for the points which have a Stabilisation state.
State: dropdown list which allows the stack point to be set to Stabilisation or
Emission. In Stabilisation state channels will be marked with a calibration status. In
Emission state channels will not be marked with a calibration status.
Time (min): duration that the stack point will last before moving on to the next point.
Digital Outputs: each digital output in the system will be shown to the right of the
Time column. Each output in each point can be set with a value (Hi, Lo or no change)
which will be activated when the system is running the point.
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View Menu

The View menu allows users to access information and data from the instruments.
This data can be in real time Instantaneous data, or Historical data. This data can be
accessed either in the form of data readings, or in a graphical format such as a line
graph.

5.1 Calibration Status
The Calibration Status window shows the current calibration state of the WinAQMS
Mini DAS. All sequences and points are listed on a separate row in the Calibration
Status table which also shows the Label, Point Type, Starting Date/Time, Duration
(min) and Average Duration (min). When a sequence and point is active they will be
displayed with a yellow background. The text colour will be black if an automatic
sequence/point is running and red if a manual sequence/point is running. Any points
in an active sequence that are not currently running will not show up with a yellow
background. When a point is running the Average Duration (min) column will show
as being active only when the Span or Zero report for the point is being calculated.

Figure 49. Calibration status window

5.2 Channel List
The Channel list window provides a streamlined view of the channels and the
instruments associated with them. The first column lists the channel number and
name, in column two the analyser from which data is being acquired for that channel
is listed and the third column has the communication port that WinAQMS Mini DAS
is receiving the data through. As shown below in Figure 50 multiple channels can be
serviced by the same instrument running through the same communications port. The
list can be ordered by channel, analyser or port number by clicking on the heading of
the respective column. This list can be exported to a comma delimited text file by
pressing the “Export to text” button or to a H.T.M.L. formatted file by pressing the
“Export to HTML” button.

45

Edit Menu

WinAQMS Mini DAS User manual 1.0

Figure 50 Channel list screen

5.3 Historical Data
The Historical Data window displays data from the database as a table.

Figure 51 Historical Data
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It has a Start Date/Time field that indicates the time of the first data value you
want to look at. The Start Date/Time has a default value of the current date with
no time specified. If no time is specified it is taken as being 12:00 midnight or
00:00 in 24 hour time for the date entered.
The End Date/Time field shows the date and time of the last data reading you
want to look at. The End Date/Time has a default value of the day after the current
day at 12:00 midnight or 00:00 in 24 hour time. It is not recommended that you
view more than 1 week‟s data as the time required to retrieve this data may
become excessive over slower communications links.
The Report Name field indicates the report you are looking at and can be one of
RPT1 (Report 1), RPT2, RPT3, RPT4, Span, Zero, Precision or All. RPT1 to
RPT4 show the data for the four reports which WinAQMS Mini DAS supports.
Span, Zero and Precision show the report data from when the channels went into
calibration. The Span and Precision reports show all 16 Span or Precision reports.
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The All option shows the data for all reports in the database for the selected time
period.
 The Find button will use the values in the Start Date/Time, End Date/Time and
Report Name fields to load the data into the grid in the centre of the window.
At the bottom of the window are nine boxes. These show the possible data status and
the colour that the data will be shown in if it has that particular status. The status
colours can be changed by clicking on the coloured box and then selecting the colour
for the status from the colour selection window. Any data that has the status will then
show up in the grid in the appropriate colour.

5.4 Historical Graph
The Historical Graph is used to display report data from the database as a graph. It
allows up to six plots of channel data to be drawn, with options for each plot as for the
Instantaneous Graph. The Historical Graph window shows the graph, channel
number and channel value boxes, and a Start and End Date/Time boxes. When the
Load Data button is pressed all data with a time stamp equal to or greater than the
Start Date/Time box and less than or equal to the End Date/Time box will be loaded
from the database.

Figure 52 Historical Graph

To view the graph data at a particular point, click on the graph and a vertical black or
white line will appear on the Graph. The data boxes at the bottom of the window will
display the data value for each plot from that time. The Current Date/Time box shows
the date and time of the data point under the black/white line. The left and right arrow
keys move the line to an earlier or later data point.

Historical Graph Settings
Access this through the Graph Settings button on the Historical Graph window. Each
of the six plots of channel data can be configured individually to suit the needs of the
channel it is plotting.
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Figure 53 Historical Graph Settings with Plot Settings



The Plot Drawn option will set whether a plot is drawn. If this option is not
selected the data will still be present but the plot will not be drawn.

Channel determines which channel the graph will be plotting.

Normal Data Colour is the colour that the plot will use when the data for the
channel is equal to or below the high alarm value and equal to or above the
low alarm value. To change the Normal Data Colour click on the box with
the plot colour and a colour selection window will appear which will give
you the option of selecting one of several predetermined colours or making
your own colour.

The High Alarm Colour and Low Alarm Colour can be changed in the same
way as the Normal Data Colour.
The Show Axis Settings/Show Plot Settings button allows you to toggle between the
settings for the plots and the settings for the axes.

Figure 54 Historical Graph Settings with Axis Settings







Axis Colour is the colour of the axis for the plot.
To remove the axis for a specific channel remove the tick from the Axis
Shown box.
AutoScale will scale the axis based on the data that has been plotted since
the plot was started. Autoscaling will give the axis a maximum value just
above that of the largest value received and a minimum of just below that of
the smallest value received.
If you do not want the plot to use the autoscaled axis then remove the tick in
the AutoScale box, which will then enable the Max. and Min. Axis Value
boxes. Entering values in these two boxes will set the maximum and
minimum values for the axis and scale the plot using those values.

Available in both Plot Settings and Axis Settings modes are:

Graph Background Colour, which sets the colour that will appear as the
background colour for the graph. It can be changed like the other colour
selections.
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Display Scheme, which will load the settings of a particular scheme.
Report, which shows which report will be displayed on the graph.

5.5 Instantaneous Data
The Instantaneous Data window shows up to ten
channels with their most recent data and the units of
the channel. Clicking on a dropdown box allows you
change the channel for which the data is displayed.
The window is updated at the speed of the fastest
channel in the system. If the Instantaneous Data menu
option or button is selected when there is already an
Instantaneous Data window visible then a second
window will be displayed. Each of the Data boxes is
shown in a colour indicating its status. An extra field
at the bottom is Display Scheme, which will load the
settings of a particular scheme.

Figure 55 Instantaneous Data

5.6 Instantaneous Graph
The Instantaneous Graph
gives a visual plot of data
as WinAQMS Mini DAS
receives it. The graph can
show up to six plots
simultaneously,
each
using different axes, plot
colours and axis colours.
For each channel plotted,
the vertical scale can be
shown as an axis in any
colour. The axes can be
Figure 56 Instantaneous Graph
set to have a fixed range
or to auto-scale to match the data that is being plotted. Each plot can be enabled or
disabled and can be shown in a unique colour. To change the settings for the
Instantaneous Graph select the Graph Settings button, which will load the Graph
Settings window.
Graph data from a particular time can be viewed in the same way as for the Historical
Graph, (with the black/white line). As time passes, the line and plots will move
towards the left edge of the screen as new data values arrive. When the line goes off
the left edge of the screen the data values displayed at the bottom of the screen will
return to being the most recently logged values.
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Instantaneous Graph Settings
Access this through the Graph Settings button on the Instantaneous Data Graph
window. Settings for the Instantaneous Graph are the same as for the Historical
Graph except that the Report list box is replaced with a Graph Time Frame and a
Graph Redraw Period (Refer to Section 2.10.1, Historical Graph Settings for
explanation of the other options.)

Figure 57 Instantaneous Graph Settings with Plot Settings




Graph Time Frame, sets the length of time that the graph will retain data for. If
the Graph Time Frame is set to 10 minutes then all displayed plots will show data
for the last ten minutes.
Graph Redraw Period, sets the interval at which the graph redraws. The data from
the analysers will continue to be stored by the graph but will not be displayed until
the graph redraw period is up. Clicking on the graph or using the keyboard to
display the white line will also cause the graph to redraw itself.

Figure 58 Instantaneous Graph Settings with Axis Settings

5.7 Instantaneous Wind Speed/Direction
The Wind Speed and Direction window displays the wind speed and direction data in
graphical form. The data points can be positioned either towards or away from the
wind source and will be positioned according to the magnitude of data. If the data
value goes over the high alarm value or under the low alarm value for the channel the
data points can be set to change colour when this occurs. Data is displayed as a dot,
cross, plain line or one with an arrow head. These data points, along with the rest of
the graph, can be customised within the settings menu (see below).
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Figure 59 Wind Speed and Direction

Figure 60 Wind speed and direction Settings
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Wind speed and direction settings
Display Type:

The readings can be shown as a dot, cross, line with an arrow
head or a line. The data can be shown as towards the source of
the reading or away from the source of the reading.
Example: Instead of an arrow pointing into the wind it can be
set to point in the direction of the wind.
Line Width:
The line, dot or cross can be made larger using the Line Width
parameter.
Max WS:
The maximum wind speed parameter is the radius of the wind
rose.
Data Count:
Shows how many readings will be shown on the wind rose.
Data Colour:
This field allows the colour of the data point to be chosen.
Text Type:
The type of labels shown on the edge of the wind rose.
Text Colour:
This field allows the colour of the text (shown on the edge of
the wind rose) to be selected.
Data History Fade: This will fade data as it gets older. Each time new data is shown
the older data will change more in colour to that of the
Background Colour.
Background Colour: This field allows the colour of the background of the wind rose
to be selected.
Show High
Alarm Level:
If the Wind Speed channel has a high alarm value set then a
dashed circle will be shown on the wind rose at this level.
High Alarm
Level Colour:
This field allows the colour of the high alarm dashed line to be
selected.
Change High
Alarm Data Colour: If set this will change the colour of any data readings which are
above the high alarm level.
High Alarm
Data Colour:
This field allows the colour of the high alarm data readings to
be selected.
Show Low
Alarm Level:
If the Wind Speed channel has a low alarm value set then a
dashed circle will be shown on the wind rose at this level.
Low Alarm
Level Colour:
This field allows the colour of the low alarm dashed line to be
selected.
Change Low
Alarm Data Colour: If set this will change the colour of any data readings which are
below the low alarm level.
Low Alarm
Data Colour:
This field allows the colour of the low alarm data readings to be
selected.
Show Magnitude
Markers:
This will enable markers to indicate the numeric value of the
data reading
Magnitude Marker
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Show Sector
Markers:
Sector Marker
Colour:
Magnitude Marker
Interval:
Sector Marker
Interval:
Display Scheme:
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This field allows the colour of the magnitude markers to be
selected.
This will split the wind rose into sectors like a pie graph.
This field allows the colour of the sector markers to be selected.
This is the spacing between successive magnitude markers.
This is the spacing of the sector markers (in degrees).
This field will load the settings of a particular scheme the user
has defined previously

5.8 Sizeable Font Data Value
The sizeable font data value displays a single channels data value with user specified
font settings.

Figure 61 Sizeable Font Data Value Window

Double clicking on the window will open the settings window.

Figure 62 Font size Settings Window
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The settings window has the following settings:
Channel:
allows you to specify which channel to display.
Use Status Colours: allows you to specify if the colours used by the window will
match those specified in Historical Data.
Back Colour:
allows you to specify a background colour to use if you do not
want to use the system status colour scheme.
Show Label:
allows you to control if the channel label is shown in the
window.
Show Units:
allows you to control if the channel units are shown in the
window.
Font button:
allows selection of font settings such as style and size.
Display Scheme:
is the display scheme used by this window.
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Manual Menu

The Manual menu is designed to allow the user to manually perform Calibrations,
communicate with software and alter other software aspects.

6.1 Start Calibration
The Start Calibration option on the Manual menu will manually start the calibration
for the selected channel. When the Start Calibration menu item is chosen you will be
asked if you want to disable scheduled calibrations. This will disable the automatic
calibrations for all channels. If you want the scheduled automatic calibrations to be
disabled then select the Yes button. If you do not want scheduled calibrations to be
disabled while you are running manual calibrations then select No.
If you choose to disable scheduled calibrations then any automatic calibration that had
already started will be aborted and any calibration that is set to start while this
window is open will not do so. The reason this option is given is to stop automatic
calibrations, which may change digital outputs, from interfering with the running of
manual calibrations.
This option is used to stop automatic calibration, which may change digital outputs,
instrument states and calibration settings, causing conflicts with the manual
calibration.

Figure 63 Start Manual Calibrations

Once a selection is made a window like that shown in Figure 63 will open. The
sequence/point will begin calibrating using the same digital inputs and outputs and the
same span, zero and precision times as was set for the automatic calibration . If the
channel was already in the middle of a calibration then it will drop out of the current
calibration, complete the requested manual calibration and then set its next calibration
time to occur as if the manual calibration did not occur. This means a manual
calibration will not mess up the timing of scheduled calibrations in the future. The
Sequence and Points options allow the user to choose which sequence or which point
from the sequence they wish to run manually (these sequences and points were
created in section 4.2.4 Calibration control). The duration is automatically updated to
the normal time taken for that point but can be altered when an individual point is
manually calibrated. Press the Run Sequence or Run Point button to run the selected
sequence or specific point. The Stop button will stop any manual calibration in
progress for that sequence.
The timeout value (defaults to 120 minutes) decrements every minute. When the
timeout value reaches 0 the Manual Calibration window will close. When the
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window closes all manual calibrations will end and all automatic calibrations will be
enabled once again. To reset or update the timeout type a new numeric value within
the timeout box and click on the Reset Timeout button. The timer will now count
down from this new number.
Note: If the start time for an automatic calibration passes
while calibrations have been disabled the calibration time
will move on to its next scheduled start time.

6.2 Communicate with Serial Port
The Communicate with Serial Port option on the Manual menu allows you to
communicate directly with the desired communications port using the settings shown
on the window. It allows you to select the communications port you want to
communicate with, the baud rate, the parity, data bits, stop bits and handshaking you
want to use.

Figure 64 Communicate with Serial Port







Once all the communication settings have been entered click on the Connect
button. The logger will suspend logging on the selected communication port and
attempt to open it with the given settings. If the connection request succeeds then
a message will appear in the status bar of WinAQMS Mini DAS saying „Talking
directly to serial port‟.
To send data to the port, type the message into the Send Text box and then hit the
Send button. The message will be sent to the port you are connected to. Any
response from the port will be shown in the Receive Text box.
If the Receive Text box is becoming too cluttered with text then clicking the Clear
Receive Text button will remove all text from the Receive box.
Once you have finished communicating with the port click on the Disconnect
button and WinAQMS Mini DAS will release the port and display the message
„Communication port released‟. If WinAQMS Mini DAS was using the port
previously to log data then it will resume doing so.

If there is a check in the Convert non-printing characters checkbox then ASCII
characters can be sent to the serial port (or printed when they are received) by
enclosing the ASCII character code in square brackets. For example to send a data
request to a R&P Teom instrument with a PRC# of 8 you need to send the string
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<STX>4AREG K0 8<ETX>
There is no key on the keyboard to send an STX character (ASCII code 2) or an ETX
character (ASCII code 3) but when the Convert non-printing characters option is set
you could send the string
[2]4AREG K0 8[3]
If the Convert non-printing characters checkbox is set then WinAQMS Mini DAS
knows to replace the [2] with an STX and the [3] with an ETX.
Any non-printing characters in the responses from the analysers will also be converted
to their ASCII codes and put into square brackets when shown in the Receive Text
box.

6.3 Communicate with Analyser
WinAQMS Mini DAS can
communicate with analysers which
have ANSI terminal modes. To
communicate with an analyser,
choose the Communicate with
Analyser option on the Manual
menu and select the analyser from
the dropdown box. The dropdown
box contains information which
will uniquely identify the analyser
such as analyser number, label,
manufacturer, model, ID and the
communication port the analyser
uses. Once a selection has been
made click on the Connect button
and the terminal screen for the
analyser will come up in the black
screen on the window. When you
have finished using the analyser in
Figure 65 Communicate with Analyser
terminal mode click on the
Disconnect button and WinAQMS
Mini DAS will release the communications port so that normal logging can be
resumed.
Note: When using a communication port to
communicate with an analyser in terminal mode
WinAQMS Mini DAS will suspend all logging on
that port. There is no timeout on this operation.

The Ecotech and Monitor Labs 98XX series analysers, Serinus series, Ecotech Aurora
Nephelometers and Ecotech Gascal-1100 have terminal modes. WinAQMS Mini
DAS can display a Graphical User Interface (G.U.I.) for the settings of an Ecotech
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GasCal-1100 calibrator. To use the G.U.I. interface an Ecotech GasCal-1100 must be
selected from the list and the GUI checkbox must be selected. A set of four tabs
containing settings will be shown after the Connect button is pressed as shown in
Figures 65 66 67 and 68. These settings cover points, gases, alarms and factory
settings.
Note: To use the G.U.I. interface for the Ecotech GasCal-1100
the calibrator must be running firmware version 2.0.6 or later.
Factory Settings should only be changed by qualified personnel
as they will affect the calibration of the GasCal.

Figure 66 Ecotech GasCal 1000 point settings

Figure 67 Ecotech GasCal 1000 gas settings
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Figure 68 Ecotech GasCal 1000 Alarm settings

Figure 69 Ecotech GasCal 1000 factory settings
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6.4 Digital Outputs
Digital Outputs is an aid which can be used to help check calibration sequences as
well as the functionality of digital outputs. When this option is selected a window
similar to Figure 74 will be displayed.
If you choose to disable scheduled
calibrations then any automatic
calibration that had already started will
be aborted and any calibration that is
set to start while this window is open
will not do so. The reason this option is
given is to stop automatic calibrations,
which may change digital outputs,
from interfering with the manual
changing of digital outputs.
Figure 70 Disabling scheduled
calibrations

After a choice is made, to enable or
disable scheduled calibrations is made a
window similar to the one in Figure 75 is
shown. It lists all digital output channels
and their current digital state. To change
an outputs state click on the State button to
the right of the Channel and it will toggle
between Hi and Lo.
The timeout value (defaults to 120
minutes) decrements every minute. When
the timeout value reaches 0 the Manual
Digital Outputs window will close. When
the window closes all automatic
calibrations will be enabled once again. To
reset or update the timeout, change the
numeric value in the timeout box and click
on the Reset Timeout button.
Note: If the start time for an automatic
calibration passes while calibrations have
been disabled the calibration time will move on
to its next scheduled start time.

Figure 71 Manually setting digital
outputs
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6.5 Channel State
Channel state allows the Out of Service status to be set for each channel. The channel
can be set to be out of service for a specified duration of time or indefinitely.
Current State: Is the current state of the channel (Normal or Out of Service)
Set New State: This checkbox tells WinAQMS Mini DAS to update the channel with
a new state (specified in the New State field) when the OK button is pressed.
New State: This list shows the new state (Normal or Out of Service) to which a
channel will be changed.
Duration and Unit: These two fields show the time that a channel will be set to be
out of service.
Timeout Date/Time: This field shows when a channel with a Current State of Out of
Service will return to Normal state. It also will set the timeout time for a channel
All Out of Service: This button will set the Set New State checkbox to checked and
the New State listbox to Out of Service for all channels. The All Normal button will
set the Set New State checkbox to checked and the New State listbox to Normal for
all channels.
In this diagram channel 30 (CO) has been set to the Out of Service state until 2007/3/9
17:06:23, channel 50 (SO2) has been set to the Out of Service state indefinitely and all
other channels are running normally.

Figure 72 Channel State

6.6 Restart Server
When the Restart Server option is selected all logging is suspended and all settings
will be loaded from the database. Once the settings have finished loading, WinAQMS
Mini DAS will begin logging with those settings. During this restart a small number
of data readings may not occur. This process takes about 10 seconds.

6.7 Suspend/Resume Logging
This option, available from the Manual menu, will stop all logging being done by
WinAQMS Mini DAS until the option is again selected. Once Suspend Logging has
been chosen its text will become Resume Logging. Communication ports will not be
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released by the activation of this option and will remain open but unused by
WinAQMS Mini DAS.

6.8 Stop Server
This option will bring up a confirmation window as shown below in Figure 73.
Selecting OK will terminate WinAQMS Mini DAS including the server part of the
program and will stop all logging.

Figure 73 Stop Server confirmation box
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In the example in this manual you will be shown how to configure WinAQMS Mini
DAS using the basic database which is included on the WinAQMS Mini DAS CD and
then to add analysers and channels to build up a more complex system. It is
recommended that you read section 3-6 of this manual to become familiar with the
layout and capabilities of WinAQMS Mini DAS before going through this example.
Start WinAQMS Mini DAS by going to the
Start menu and clicking on the Start button,
select Programs (All Programs for Microsoft
Windows XP), move to the WinAQMS Mini
DAS Client icon and select WinAQMS Mini
DAS Client. WinAQMS Mini DAS will
load and display the screen shown below,
then goes to the main WinAQMS Mini DAS
screen.

Figure 74 WinAQMS Mini DAS Loading

The basic database that comes with WinAQMS Mini DAS has two channels. They are
a temperature channel and a Carbon Monoxide channel. The temperature sensor is a
basic device connected to an Ecotech Termination Panel (TP). The Carbon Monoxide
channel data is supplied by a Ecotech EC9830 analyser.
On the menu bar select Edit and then Analyser Parameters. The two analysers should
have settings matching those in Table 4.
Table 4: Initial Analyser Settings

Ecotech TP
Ecotech EC9830
INFORMATION
Label
TP
9830
Manufacturer
Ecotech
Ecotech
Model
Termination Panel 98XX
Device ID
0
30
Data Request Period 10
10
Max Response Time 1
1
Request Delay
0
0
COMMUNICATION SETTINGS
Connection Type
Serial RS232
Serial RS232
Serial Port
2
3
Baud Rate
4800
9600
Data Bits
8
8
Parity
None
None
Stop Bits
1
1
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The two channels in the system should have the channel information settings
matching those in table 5 below.
Table 5 Initial database channel settings

System Channel #
Label
Analogue Input #
Multiplier
Offset
Units
Decimal Places
High Alarm
Low Alarm
Alarm Number
Valid Data High
Valid Data Low
Channel Type
Process
Description
Log Report 1
Log Report 2
Log Report 3
Log Report 4
Out of Service
Serial Port Output
Alternate File Output

TP Temperature Channel
1
Temp
16
100
-273
°C
1
40
0
1
0
0
Voltage
Average
Ambient Temperature
Set (ticked)
Set (ticked)
Set (ticked)
Set (ticked)
Unset (not ticked)
Set (ticked)
Set (ticked)

9830 CO Channel
2
CO
N/A
1
0
ppm
2
4
0
2
0
0
Voltage
Average
Carbon Monoxide
Set (ticked)
Set (ticked)
Set (ticked)
Set (ticked)
Unset (not ticked)
Set (ticked)
Set (ticked)

Select the Calibration control tab and an almost empty table will appear. While there
is nothing in there yet, this option allows you to set which digital channels go
high(H)/low(L)/no change when the analogue channels on the analyser go into
calibration.
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We will now add a barometric pressure, wind speed and wind direction channel to the
channels on the TP. Switch to analyser number 1 on the Analyser Parameters
dropdown list and choose the information tab. Click on the Add Channel button three
times. Three new channels will be added to the list and they will have default values
entered into most of their columns. Make sure the settings match those of table 6
below
Table 6 Settings for the pressure, wind speed and wind direction channels

System Channel #
Label
Analogue Input #
Multiplier
Offset
Units
Decimal Places
High Alarm
Low Alarm
Alarm Number
Valid Data High
Valid Data Low
Channel Type
Process
Description
Log Report 1
Log Report 2
Log Report 3
Log Report 4
Out of Service
Serial Port Output
Alternate File Output

TP Pressure
3
Pressure
2
60
800
Mbar
0
1030
980
2
0
0
Voltage
Average
Barometric Pressure
Set (ticked)
Set (ticked)
Set (ticked)
Set (ticked)
Unset (not ticked)
Set (ticked)
Set (ticked)

TP WS
4
WS
13
1
0
m/s
1
20
0
3
0
0
Frequency
Average
Wind Speed
Set (ticked)
Set (ticked)
Set (ticked)
Set (ticked)
Unset (not ticked)
Set (ticked)
Set (ticked)

TP WD
5
WD
3
72
0
deg
0
370
-10
4
0
0
Voltage
Average
Wind Direction
Set (ticked)
Set (ticked)
Set (ticked)
Set (ticked)
Unset (not ticked)
Set (ticked)
Set (ticked)

Now press the OK button on the Analyser Parameters window. This will save the
settings to the database. You may notice that the Restart Server button is not enabled
at this time. This allows WinAQMS Mini DAS to have sufficient time to write the
settings to the database before you restart the server again with the updated settings.
The wind speed and direction sensor that is being used is an analogue output MetOne034 sensor.
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We have now added three channels to the TP which record barometric pressure and
wind speed and direction. To vector average the wind speed and direction channels
two calculated channels are needed. On the menu bar select Edit and then select
Calculated Channels. The calculated channels window will load and show an empty
table. Click on the Vector Averaged Channels tab and then add two new channels.
Enter the channel settings as shown in table 7 below.
Table 7 Settings for the vector averaged wind speed and wind direction channels

System Channel #
Label
Magnitude Source
Channel
Direction Source
Channel
Magnitude Channel
Direction Channel
Sigma Theta Channel
Multiplier
Offset
Units
Decimal Places
High Alarm
Low Alarm
Alarm Number
Valid Data High
Valid Data Low
Description
Log Report 1
Log Report 2
Log Report 3
Log Report 4
Out of Service
Serial Port Output
Alternate File Output

Vector WS
6
WS Ave
4

Vector WD
7
WD Ave
4

5

5

Set (ticked)
Unset (not ticked)
Unset (not ticked)
1
0
m/s
1
20
-1
6
0
0
Vector averaged WS
Set (ticked)
Set (ticked)
Set (ticked)
Set (ticked)
Unset (not ticked)
Set (ticked)
Set (ticked)

Unset (not ticked)
Set (ticked)
Unset (not ticked)
1
0
deg
0
370
-10
7
0
0
Vector averaged WD
Set (ticked)
Set (ticked)
Set (ticked)
Set (ticked)
Unset (not ticked)
Set (ticked)
Set (ticked)

Click on the OK button at the bottom left corner of the window to save the changes
you have just made and to restart the WinAQMS Mini DAS Server process with the
changes. The vector averaged wind speed and direction channels are now set up and
will begin logging.

Now we will add a Ecotech 9841 oxides of Nitrogen analyser and a 9850 Sulfur
Dioxide analyser. These two analysers will be multi-dropped together with the
Ecotech 9830 carbon monoxide analyser that is already set up on the system.
Open the Analyser Parameters window and click on the Add New Analyser button.
This will add a new analyser to WinAQMS Mini DAS which will be an Ecotech
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Termination Panel by default and have all of its parameters set to default values.
Change the Model of the analyser to be 9841. The picture in the top right hand corner
should change to show an Ecotech analyser. Enter settings for the analyser as shown
in table 8.
Table 8 Settings for the Ecotech 9841 Nitrous Oxide analyser.

Ecotech EC9841
INFORMATION
Label
9841
Manufacturer
Ecotech
Model
9841
Device ID
41
Data Request Period 10
Max Response Time 1
Request Delay
0
COMMUNICATION SETTINGS
Connection Type
Serial RS232
Serial Port
3
Baud Rate
9600
Data Bits
8
Parity
None
Stop Bits
1

Note: Remember to set the baud rate on
the Ecotech EC9800 analyser to 9600 and
the Main Gas ID to 041 to match the
settings in WinAQMS Mini DAS.
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Add 3 channels with settings shown in table 9 to the new analyser and then hit OK.
Table 9 Settings for the NO, NOx, and NO2 channels.

System Channel #
Label
Multiplier
Offset
Units
Decimal Places
High Alarm
Low Alarm
Alarm Number
Valid Data High
Valid Data Low
Channel Type
Process
Description
Log Report 1
Log Report 2
Log Report 3
Log Report 4
Out of Service
Serial Port Output
Alternate File Output
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9841 NO Channel
8
NO
1
0
ppm
4
0.1
0
8
0
0
NO
Average
Nitrogen Monoxide
Set (ticked)
Set (ticked)
Set (ticked)
Set (ticked)
Unset (not ticked)
Set (ticked)
Set (ticked)

9841 NOx Channel
9
NOx
1
0
ppm
4
0.4
0
9
0
0
NOX
Average
Nitrous Oxide
Set (ticked)
Set (ticked)
Set (ticked)
Set (ticked)
Unset (not ticked)
Set (ticked)
Set (ticked)

9841 NO2 Channel
10
NO2
1
0
ppm
4
0.1
0
10
0
0
NO2
Average
Nitrogen Dioxide
Set (ticked)
Set (ticked)
Set (ticked)
Set (ticked)
Unset (not ticked)
Set (ticked)
Set (ticked)
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Add another new analyser to be the 9850 and changes its settings to match table 10
and a new channel to the analyser to match table 11.
Table 10 Settings for the Monitor Labs 9850 Sulfur Dioxide analyser.

Ecotech EC 9850
INFORMATION
Label
9850
Manufacturer
Ecotech
Model
98XX
Device ID
50
Data Request Period 10
Max Response Time 1
Request Delay
0
COMMUNICATION SETTINGS
Connection Type
Serial RS232
Serial Port
3
Baud Rate
9600
Data Bits
8
Parity
None
Stop Bits
1
Table 11 Settings for the Sulfur Dioxide channel

System Channel #
Label
Multiplier
Offset
Units
Decimal Places
High Alarm
Low Alarm
Alarm Number
Valid Data High
Valid Data Low
Process
Description
Log Report 1
Log Report 2
Log Report 3
Log Report 4
Out of Service
Serial Port Output
Alternate File Output

9850 SO2 Channel
11
SO2
1
0
ppm
3
0.1
0
11
0
0
Average
Sulfur Dioxide
Set (ticked)
Set (ticked)
Set (ticked)
Set (ticked)
Unset (not ticked)
Set (ticked)
Set (ticked)

We have eleven channels on the system, each of which will log the appropriate
analyser on the appropriate communications port. Now we will add two digital output
channels that can be used to switch solenoids when the SO2 analyser goes into
calibration.
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Again open the Analyser Parameters window and go to the Digital Output Settings tab
for analyser 1. Add two digital output channels to the analyser and make their settings
like table 12.
Table 12 Settings for the two digital output channels.

System Channel #
Label
Output #
Default Output
High Value
Low Value
High Alarm
Low Alarm
Description
Log Report 1
Log Report 2
Log Report 3
Log Report 4
Out of Service
Serial Port Output
Alternate File Output

TP Pressure
12
Dig Out 1
0
Lo
1
0
0
0
Digital Output 1
Set (ticked)
Set (ticked)
Set (ticked)
Set (ticked)
Unset (not ticked)
Set (ticked)
Set (ticked)

TP WS
13
Dig Out 2
1
Lo
1
0
0
0
Digital Output 2
Set (ticked)
Set (ticked)
Set (ticked)
Set (ticked)
Unset (not ticked)
Set (ticked)
Set (ticked)

Now we have to put in the settings for the digital outputs for the SO2 analyser.
Change the Analyser to be 4 and save any settings to the current analyser. Select the
Calibration Control tab.
Add a new sequence to the list by clicking on the Add Sequence button. A new
sequence will be added to the list and default values will be set. Set the sequence label
to be “SO2 Cal”. Click on the Add Point button 3 times to add 3 points to the
sequence and set the settings as shown in table Table 13 below.
Table 13 Settings for the three new sequences

Point
Label
Point type
Duration
Ave duration
12: C12
13:C13
2:9850
11:SO2

Point 1
Point 2
1
2
SO2 Span
Zero
Span
Zero
20
20
2
2
SEQUENCE SETTINGS
Hi
Lo
Lo
Hi
Span
Zero
PRECISION
50
0

Point 3
3
Stabilise
Stabilise
20
2
Lo
Lo
Measure
0

Select channel 11 from the channel list and click on the precision Values tab. Enter
the precision value for the SO2 channel for point 1.
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Click on Restart Server when the button is enabled and display the instantaneous data
window. When the time reaches the time you entered for the calibration to begin the
digital output channels should change from a value of 0 to the sequence that was
entered into the Calibration Settings for the SO2 channel and the Ecotech 9850
analyser should change its calibration state.
This concludes the example of setting up channels on WinAQMS Mini DAS.
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The following Modems are compatible with the WinAQMS Mini DAS
system:

Siemens M1 GSM.
Siemens M20 GSM.
Siemens TC35i Dual Band GSM.
Falcom A2D1 GSM
Falcom A2D3 GSM with SMS.
Netcomm Mymodem 56 external landline
ETM 9500i Dual Band GSM with SMS
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Ecotech EC9800 Series Analysers
Features:
 The WinAQMS Mini DAS supports both A and B series EC9800 analysers as well as
all versions of software.
 The Ecotech EC9800 series analysers all have multidrop RS232 communications ports
on the rear. In fact there are two in parallel.
 Each analyser can have an individual address (Main Gas I.D.).
 All EC9800 analysers can be connected in a daisy chain configuration to one RS232
port on the WinAQMS Mini DAS. i.e. If you have four 9800 analysers, you only need
to use one RS232 port on the rear of the logger.

Ecotech EC9800 Setup
Before connecting to the analysers you must first set the address of each analyser. The preferred
addressing convention is to use the analyser type as the address. e.g. for 9841A use 041, for 9850
use 050 for 9830 use 030 …etc.
There are two ways to set the address:


In the 9800 main menu select "Instrument Menu". Then, in the field for "MAIN GAS
ID" enter the address. This method is the easiest.



For analysers with older versions of software and do not have the Main Gas ID in their
menu, you will have to use the following procedure.
1. Set the 9800 analyser‟s Multidrop Baud Rate in the Interface Menu. Also make
sure that it is in COMMAND mode not TERMINAL made. The default setting
is usually 38400 baud for Ecotech 9800‟s and 2400 for Monitor Labs 9800‟s.
2. Connect the RS232 cable from the analyser to the WinAQMS Mini DAS. Only
connect one analyser at a time.
3. From the WinAQMS Mini DAS Manual menu select Communicate with
RS232. Set the port number as well as the baud rate and connect to the port.
4. By typing DCONC,???<enter> will cause the analyser to respond as long as its
main gas ID is not 000. If there is no response then check your
communications setup and RS232 cable.
5. Send the command PInnn<enter> where nnn is the 3 digit address for the
analyser. E.g. for 9850 use PI050<enter>.
6. You can test the analysers operation by typing DCONC,nnn<enter> (eg
DCONC,050). The analyser should respond with the instantaneous
concentration and a status word.
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TEOM Continuous Particulate Monitor
The 1400A and 1400AB TEOMs can be directly connected to the WinAQMS Mini DAS via
RS232. The TEOM also has the added feature of monitoring all its internal parameters. For
example you can record the filter loading of the TEOM and hence remotely determine if the filter
needs to be changed.

TEOM Setup
For RS232 communication between the TEOM and the WinAQMS Mini DAS the TEOM has to
be in "AK Protocol" mode. If it is in AK Protocol mode the top line of the TEOM display should
read "AU" next to the filter loading.
If not, on the TEOM front panel press the RS232 button. If the Mode is not AK Protocol then
press the down arrow until the cursor is pointing to AK Protocol then press Enter.
The TEOM has a station number or address. The factory default address used by TEOM is 4
(ASCII 52). There is no need to change this. However, if you need to change the address, proceed
as follows:
1. Press Step Screen until the COM 2-Way Settings screen is displayed.
2. If RS-Para 1 is not equal to the ASCII code of the selected station number then set the
cursor against RS-Para 1 and press Edit.
3. Key in the selected ASCII number (ASCII 52 for address 4) and press Enter.
4. Press Main to exit setup.
The program register codes are listed in Appendix A in the TEOM 1400a manual.

DANI TNMH Hydrocarbons Analyser
The AQMS software supports RS232 communications with the DANI TNMH 451 & 452
Hydrocarbon analysers.
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The only parameters available from the DANI are MET (CH4 or Methane), NMHC
(Non Methane Hydrocarbons) and THC (Total Hydrocarbons).
All readings are in ppm.
The default baud rate is 9600 baud.
There is no address or physical input number.
If there is a flame fail condition or other alarm condition, there will be data but it will
be marked as having an instrument fault status.
When the DANI switches from MR to LINE measure and back again (every 3
minutes), AQMS will not read data for a short time (approx 30 seconds) to allow for
the reading to stabilise.
When the DANI switches from MR to LINE measure a back again (every 3 minutes),
WinAQMS Mini DAS will not be able to read a new data value for a short time but
instead will use the last data value before the DANI switched to the LINE measure.
When configuring WinAQMS Mini DAS you should set the "% Samples for valid
report" to no more than "70%" in the System Parameters.
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Table 14 USB Protocol Parameter list

#
0
1
2
3
4
5
6
7
8
9
10
11

Description

12

PRE POT 2

13
14

PRE POT 3
PRE POT 4

15

PRE POT 5

16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37

PRE POT 6
PRE POT 7
VREG POT 1
VREG POT 2
VREG POT 3
VREG POT 4
VREG POT 5
VREG POT 6
VREG POT 7
Analogue input 0
Analogue input 1
Analogue input 2
Analogue input 3
Analogue input 4
Analogue input 5
Analogue input 6
Analogue input 7
Analogue input 8
Analogue input 9
Analogue input 10
Analogue input 11
Analogue input 12

Internal Valve 1
Internal Valve 2
Internal Valve 3
External Measure Valve
External Zero Valve
External Span Valve
Aux Valve 1
Aux Valve 2
Aux Valve 3
Valve Sequencing
LCD Contrast POT
PRE POT 1

Notes
0=Closed, 1=Open
0=Closed, 1=Open
0=Closed, 1=Open
0=Closed, 1=Open
0=Closed, 1=Open
0=Closed, 1=Open
0=Closed, 1=Open
0=Closed, 1=Open
0=Closed, 1=Open
0=Off, 1=On
0=Lightest, 99=Darkest
Measure coarse pot for all analysers except
9841A which is chassis fan speed.
Measure Fine: 981X, 9820, 9830, 9841, 9842
Bench Fan Speed: 9841A
Reference_zero : 9850
Input for all except 9850 which is measure gain.
981X, 984X: Test Measure
9820, 9830: test_reference
9850: reference gain
981X: Lamp Adjust
9820,9830,9850:test measure
984X: high voltage adjust
9850: high voltage adjust
9850: lamp adjust
Flow control zero

Fan speed control
Pump speed fine
Pump speed coarse
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39
40
41

Analogue input 13
Analogue input 14
Analogue input 15
50 PIN IO bits 0-7

42

50 PIN IO bits 8-15

43

50 PIN IO bits 16-23

44
45

50 PIN IO bits 24-31
50 PIN IO bits 32-39

46

50 PIN IO bits 40-47

47

50 PIN IO bits 48-55
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BIT 7: Span Out of Range
BIT 6: Span On
BIT 5: Copper Fail
BIT 4: Zero On
BIT 3: Lamp Fail
BIT 2: Out Of Service
BIT 1: Flow Fail
BIT 0: Span Cycle
BIT 7: Pump On
BIT 6: Range 1
BIT 5: Startup
BIT 4: Heater Fail
BIT 3: Range 0
BIT 2: IZS On
BIT 1: Spare 1
BIT 0: ZeroCycle
BIT 7: Power On
BIT 6: Sys Fail
BIT 5: High Voltage Fail
BIT 4: Power Supply Fail
BIT 3: Electric Test
BIT 2: Optical Test
BIT 1: Range 2
BIT 0: PPm / Metric
Really User ID
BIT 7: P4
BIT 6: P3
BIT 5: P2
BIT 4: P1
BIT 3: Spare Driver 1
BIT 2:
BIT 1:
BIT 0: Reference Fail
BIT 7:
BIT 6:
BIT 5:
BIT 4:
BIT 3:
BIT 2:
BIT 1: P6
BIT 0: P5
BIT 7: Status 2 LED
BIT 6: Status 1 LED
BIT 5: Sys Fail LED
BIT 4: HeartBeat LED
BIT 3:
BIT 2:
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48

50 PIN IO bits 56-63

49
50
51
52
53
54
55
56
57
58
59
60
61
62
63
64
65
66
67
68
69
70
71
72
73
74
75
76
77
78
79
80
81
82
83
84
85

PGA Gain
Primary Gas Concentration
Secondary Gas Concentration
Calculated Gas Concentration
Primary Gas Average
Secondary Gas Average
Calculated Gas Average
Instrument Gain
Main Gas ID
Aux Gas ID
Decimal Places
Noise
Gas 1 Offset
Gas 3 Offset
Flow Temperature
Lamp Current
Digital Supply
Concentration Voltage
High Voltage
Ozonator
Control Loop
Diagnostic Mode
Gas Flow
Gas Pressure
Ambient Pressure
Analog Supply
Cell Temperature
Converter Temperature
Chassis Temperature
Manifold Temperature
Cooler Temperature
Mirror Temperature
Lamp Temperature
O3 Lamp Temperature
Instrument Status
Reference Voltage
Calibration State

Appendix
BIT 1:
BIT 0:
BIT 7:
BIT 6:
BIT 5:
BIT 4:
BIT 3:
BIT 2:
BIT 1:
BIT 0: Status 3 LED
0-7

0=Off, 1=On

0 = MEASURE
1 = CYCLE
2 = ZERO
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86
87
88
89
90
91
92
93
94
95

Primary Raw Concentration
Secondary Raw Concentration
984X Background Concentration

96

Output Type Gas 2

97

Output Type Gas 3

98

Voltage Offset /Current Range Gas1

99

Voltage Offset /Current Range Gas2

100

Voltage Offset /Current Range Gas3

101
102
103
104
105
106
107
108
109
110
111
112
113
114
115
116

Full Scale Gas 1
Full Scale Gas 2
Full Scale Gas 3
Zero Adjust Gas 1
Zero Adjust Gas 2
Zero Adjust Gas 3
Negative 10V Supply
50 Pin IO ANIN1
50 Pin IO ANIN2
Instrument State
CO Linearisation Factor A
CO Linearisation Factor B
CO Linearisation Factor C
CO Linearisation Factor D
CO Linearisation Factor E
Instrument Units

117
118
119

Background Measure Time
Sample Fill Time
Sample Measure Time
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3 = SPAN
(before 984X background and gain)
(before 984X background and gain)
(before gain)

Calibration Pressure

Converter Efficiency
Multidrop Baud Rate
Analog Range Gas 1
Analog Range Gas 2
Analog Range Gas 3
Output Type Gas 1

0=Voltage
1=Current
0=Voltage
1=Current
0=Voltage
1=Current
0=0% or 0-20mA
1=5% or 2-20mA
2=10% or 4-20mA
0=0% or 0-20mA
1=5% or 2-20mA
2=10% or 4-20mA
0=0% or 0-20mA
1=5% or 2-20mA
2=10% or 4-20mA

20mV resolution analog input (0-5V)
20mV resolution analog input (0-5V)

0= PPM
1=PPB
2=PPT
3=mG/M³
4=µG/M³
5=nG/M³
In seconds
In seconds
In seconds
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120
121
122
123
124
125
126
127
128
129
130
131
132
133

Aux Measure Time
Aux Sample Fill Time
Background Fill Time
Zero Fill Time
Zero Measure Time
Span Fill Time
Span Measure Time
Span Purge Time
Background Pause Time
Background Interleave Factor
Calibration Pressure 2
AUX Instrument Gain
Background voltage
AUX Background Voltage

Appendix
In seconds
In seconds
In seconds
In seconds
In seconds
In seconds
In seconds
In seconds
In seconds
In seconds
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Table 15 Termination Panel connections

Markings

1
2
CH1
3
CH2

4
5
CH3
6
CH4

7
8
CH5
9
CH6
10 
11 CH7
12 CH8
13 B
14 CH9
15 CH10
16 
17 CH11
18 CH12
19 
20 CH13
21 CH14
22 
23 CH15
24 CH16
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25
26
27
28
29
30

+12V
0V
+5V
0V
F5

31
32
33
34
35
36
37
38
39
40
41
42
43
44
45
46
47
48

COM
OP0
OP1
OP2
OP3
OP4
OP5
OP6
OP7
COM
IP0
IP1
IP2
IP3
IP4
IP5
IP6
IP7

9400TP Termination Panel. Rev.C
Lightning
Input
Description
Protection
Number
Ground
Yes
Channel 1
Yes
1
Channel 2
Yes
2
Ground
Yes
Channel 3
Yes
3
Channel 4
Yes
4
Ground
Yes
Channel 5
Yes
5
Channel 6
Yes
6
Ground
Yes
Channel 7
Yes
7
Channel 8
Yes
8
Ground
Yes
Channel 9
Yes
9
Channel 10
Yes
10
Ground
Yes
Channel 11
Yes
11
Channel 12
Yes
12
Ground
Yes
Channel 13 (Frequency 1)
Yes
13
Channel 14 (Frequency 2)
Yes
14
Ground
Yes
Channel 15 (Frequency 3)
Yes
15
Channel 16 (Frequency 4) &
Yes
16
Temperature
EARTH
+ 12 volt supply
Yes
0 volt
Yes
+ 5 volt reference
Yes
Common
Yes
Frequency input (Frequency
Opto
17
5) or –12V supply
Common /0V
Yes
Output 0
Opto
0
Output 1
Opto
1
Output 2
Opto
2
Output 3
Opto
3
Output 4
No
4
Output 5
No
5
Output 6
No
6
Output 7
No
7
Common / 0V
Yes
Input 0
Opto
0
Input 1
Opto
1
Input 2
Opto
2
Input 3
Opto
3
Input 4
No
4
Input 5
No
5
Input 6
No
6
Input 7
No
7

Baud
rate
4800
4800
4800
4800
4800
4800
4800
4800
4800
4800
4800
4800
4800
4800
4800
4800

4800

4800
4800
4800
4800
4800
4800
4800
4800
4800
4800
4800
4800
4800
4800
4800
4800
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Using Hyperterminal
Start->Programs->Accessories->Communications->Hyperterminal
Name the session “Direct to Com X” where x is the number of the serial port
you are connecting to.
Connect using COM X where is the serial port the modem is connected to. ->OK
Bits per second = 19200 or 9600 depending on defaults
Data bits = 8
Parity = None
Stop Bits = 1
Flow Control = Hardware or None depending on defaults
->OK
You can now enter the AT commands required to set up the modem correctly.
The modem and sim card must be set up to be in NON-TRANSPARENT (ie error
corrected) mode. Telstra #1800636785 for sim card services (1300131816
wireless and data services). If you receive a telstra message saying that the
equipment you are calling is not compatible then the modem and sim card are
not set to the same transparency settings. The sim card must be set up to not
expect a pin code to be entered.

AT commands to set up the modem
AT&F
ATS0=0

Reset the modem to factory (default) settings
Windows will do the answering for you. (It looks for two RING
strings to come from the modem and will then issue an ATA command
to the modem)
Set the port baud rate to 9600 (note: if you change this setting
AT+IPR=9600
you will have to set the baud rate in hyperterminal to match)
AT+IFC=2,2
Set the handshaking to RTS/CTS (Hardware Handshaking). Use 0,0 for
no flow control and 1,1 for Xon/Xoff.
AT+CBST=7,0,1 Set the protocol to V32, 9600 Baud, Non-Transparent mode
AT+DS=0
Turns off V42bis data compression
AT+CSQ
Test the GSM reception strength
AT&Y0
Loads configuration 0 at modem startup
(FALCOM A2D3 ONLY) Call Line Identification Presentation
AT+CLIP=0
Set this to 0 or the modem will not work with windows.
(FALCOM A2D3 ONLY) Cellular Result Code command
AT+CRC=0
Set this to 0 or the modem will not work with windows.
&CNF GSM,,ATZ;+CSCS=”PCCP437” (FALCOM A2D3 ONLY) Loads configuration profile and
correct SMS character codes at startup (Firmware
bug workaround)
&CNF MODE,V, (FALCOM A2D3 ONLY) Set the mode to Voice Mode
AT&V
Display the current configuration (Falcom A2D3 also use &REQ CNF)
(SIEMENS ONLY) Save current configuration in position 0 (0 or 1)
AT&W0
(FALCOM ONLY) Save the current configuration
AT&W

AT+CBST=7,0,0

Other commands that aren’t normally required:
set the protocol to V32, 9600 Baud, Transparent mode (Not
Recommended as this is not error corrected)

Required sequence is
1: Reset the modem to the default settings.
2: Enter desired settings
3: Save the settings (AT&W)
4: Reset the modem by taking out the power and putting it back in.
5: Display the current configuration to ensure changes have been saved.
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6: Test the GSM reception strength. In general any value for the first number
above 10 is good reception and any value other than 99 is good for the second
value.
7: Reboot the logger.
If you are having trouble getting the modem to recognise the dial tone then
use the initialisation string
x3
which will tell the modem to not wait for a valid dial tone before dialling.

Setting up the Siemens M20 modem driver in Windows
2000/XP
Open the Control Panel ->Phone and Modem Options
go to the modems tab -> Add – Don't detect the modem. Select it from the list
-> Next
Choose the Siemens M20 GSM -> Next
Select COM X (where X is the serial port the modem is connected to) -> Finish

Setting up the Falcom A2D modem driver in Windows 2000
Open the Control Panel->Phone and Modem Options
go to the modems tab -> Add – Don't detect the modem. Select it from the list
-> Next
Choose the Standard 9600 bps modem -> Next
Select COM X (where X is the serial port the modem is connected to) -> Finish

Set up Windows 2000 to Accept Incoming Connections
Open the Control Panel->Network and Dialup Connections->Make new connection>Next->Accept Incoming Connections->Next->Chose – Standard 9600 bps Modem >Next
Do not allow virtual private connections
Select the administrator and the WinAQMS Mini DAS user to be given access to
dialup remotely->Next
Highlight Internet Protocol (TCP/IP)->Properties
Allow callers to access my Local Area Network
Specify IP addresses from 192.168.0.1 to 192.168.0.10->OK->Next->Finish.

Set up Windows XP to Accept Incoming Connections
Open the Control Panel->Network Connections->Create a new connection->Next>Accept Incoming Connections->Next->Chose – Standard 9600 bps Modem ->Next
Do not allow virtual private connections
Select the administrator and the WinAQMS Mini DAS user to be given access to
dialup remotely->Next
Highlight Internet Protocol (TCP/IP)->Properties
Allow callers to access my Local Area Network
Specify IP addresses from 192.168.0.1 to 192.168.0.10->OK->Next->Finish.
Note: Incoming connections in windows will not re-establish its connection with a modem that
has been switched off unless the logger is rebooted or the modem was disassociated with
incoming connections before it was turned off. IE if the modem loses power and the logger does
not then the logger will no longer listen for incoming connections to the modem.
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The current list of serial output report formats is as follows.
AQMS text is the same format as that used by the older Ecotech 9400DAS.
<PP><sp><RRRR><sp>><yy-mm-dd hh:mm:ss><sp><####0.####><ST><####0.####><ST>…<CR><LF>

PP - 2 letter space filled data file prefix
sp - the space character (A.S.C.I.I. 32)
RRRR – report type. One of RPT1, RPT2, RPT3, RPT4, SPAN, ZERO or PREC.
yy-mm-dd hh:mm:ss – Year, month, day, hour (24 hour), minute, second.
####0.#### - 10 digit numerical value (space filled on the left hand side). If the value uses more
than 10 digits then the format changes to a scientific format of the form M.MME+XX where
M.MM is the mantissa of the number and XX is the exponent. For example, the number 123.456
in scientific format will be changed to 1.23E+02 and the number 0.023456 will be changed to
2.35E-02.
ST – is a status character for the data reading where
* is out of service
p is analyser power failure
f is instrument fault
L data good, low alarm
> data good, high alarm
a space is good data
< data bad, not enough data
= data bad, no data
Null data is assigned a value of -9999
CR – carriage return character (A.S.C.I.I. 13)
LF – linefeed character (A.S.C.I.I. 10)
WinAQMS Mini DAS sci.
<PPP>,<RRR>,<YYYY/MM/DD
HH:NN:SS>,<CH#>,<M.MMMME+XX>,<status>,<CH#>,<M.MMMME+XX>,<status>,….<CR><LF>

PPP - is the data file prefix (1 to 3 character length)
, - comma character (A.S.C.I.I. 44)
RRR - is the report number (1 to 3 character length) where:
1 = report 1
2 = report 2
3 = report 3
4 = report 4
128 = span report
144 = zero report
160 = precision report
YYYY/MM/DD HH:NN:SS - is the date and time
CH# - the channel number
M.MMMME+XX - channel data in scientific format
status - data status (see section 8 Appendix D for more information on the WinAQMS Mini DAS
status)
CR – carriage return character (A.S.C.I.I. 13)
LF – linefeed character (A.S.C.I.I. 10)
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WinAQMS Mini DAS std.
<PPP>,<RRR>,<YYYY/MM/DD HH:NN:SS>,<CH#>,<0.####>,<status>,<CH#>,<0.####>,<status>,....<CR><LF>

PPP - is the data file prefix (1 to 3 character length)
, - comma character (A.S.C.I.I. 44)
RRR - is the report number (1 to 3 character length) where:
1 = report 1
2 = report 2
3 = report 3
4 = report 4
128 = span report
144 = zero report
160 = precision report
YYYY/MM/DD HH:NN:SS - is the date and time
CH# - the channel number
0.#### - channel data in standard numerical format with the number of decimal places specified in
WinAQMS Mini DAS.
status - data status (see section 8 Appendix D for more information on the WinAQMS Mini DAS
status)
CR – carriage return character (A.S.C.I.I. 13)
LF – linefeed character (A.S.C.I.I. 10)
Mantacom
The Mantacom format is a 3rd party format used by specific customers. The entire message is 85
characters long including the carriage return (CR) and linefeed (LF) characters and is space filled
if required.
<HH:MM:SS><sp><0.####><sp><0.####><sp>…<sp><CR><LF>
HH:MM:SS – time of the data reading
sp – space character (A.S.C.I.I. 32)
0.#### - channel data is standard numerical format with the number of decimal places specified in
WinAQMS Mini DAS
CR – carriage return character (A.S.C.I.I. 13)
LF – linefeed character (A.S.C.I.I. 10)
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WinAQMS Mini DAS stores status information for data readings as a byte. X‟s indicate that the
bit of the byte can be either a 0 or a 1.
Table 16 Bite table
BIT 7
GOOD
/BAD
0=
BAD
1=
GOOD

BIT 6

BIT 5

CALIBRATION

FAULT N/A
0 = NO
FAULT
1=
FAULT

0 = NOT IN CAL
1 = IN CAL

BIT 4 BIT 3 BIT 2 BIT 1 BIT 0
N/A

Status Description

ASCII
Code

1

0

0

X

X

0

0

0 DATA GOOD ALL OK

128

1

0

0

X

X

0

0

1 SUFFICIENT DATA

129

1

0

0

X

X

0

1

0 GOOD HIGH ALARM

130

1

0

0

X

X

0

1

1 GOOD LOW ALARM

131

0

0

0

X

X

0

0

0 NO DATA

0

0

0

0

X

X

0

0

1 NOT ENOUGH DATA

1

X

1

0

X

X

0

0

0 CALIBRATION ALL OK

64

X

1

0

X

X

0

0

1 CALIBRATION SUF. DATA

65

X

X

1

X

X

0

0

1 INSTRUMENT FAULT

33

X

X

1

X

X

0

1

0 POWER FAILURE

34

X

X

1

X

X

1

0

0 OUT OF SERVICE

36
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